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OOOOvvvveeeerrrrvvvviiiieeeewwww    aaaannnndddd    OOOObbbbjjjjeeeeccccttttiiiivvvveeeessss

This user guide and manual to Neverwinter Toolset is designed by a builder, for
other builders.  I was a builder for about one year on the Kamgarat project, and I now
work on the Pentex project.  Though my time in the toolset itself is limited, I have spent
considerable hours on many large modules.  As I searched for resources to use and people
to answer questions, I found very little on the subject, and so I taught myself most of
what I know.  What I have found did answer some questions, but I still wanted an easy
reference.

My intentions to constructing this manual are to provide beginner and moderate
level builders with another resource to draw upon.  This is by no means a replacement or
substitute for any current Neverwinter Toolset guides or tutorials, of which I have only
seen two.  This work is simply another version of help for any builder who wishes it.

Constructing a world from the toolset and seeing it in use on a net Mod is very
satisfying.  I have heard a few complaints about the lack of reference material readily
available and easy to find.  With this, and the other works I will be referencing and
mentioning, I hope any level builder can learn to build more effectively and with fewer
questions.  Building in the toolset should be fun, and I hope this work will help ease the
toolset use to this end.

What is covered in this manual will be some basic methods of module
construction.  Every topic will be discussed, and in some cases, the reader will be referred
to another guide for further details, via web address, for areas I have not worked with yet.

• Requirements?
Apart from the system requirements to run the toolset, this guide is gauged for

beginners with an interest in building.  No other requirements, other than some interest in
the toolset, are even recommended.  For scripting however, NWN uses a variation of the
C language, so having experience in the C or C++ language is recommended in that area.

• Other Guides?
For other guides into the toolset, please see the Sources and Special Thanks page

for links.

********    NNNNOOOOTTTTEEEE    ******** This format is intended for viewing in the Print Layout View in
Microsoft Word.  Other formats are not completely compatible and will make this
document nigh unreadable, especially with my visuals.  To change to Print Layout View,
go to the “View” menu bar and select it, or use the keyboard shortcut: “Alt + V + P”, or
click on the thick bordered page icon in the bottom left of the window (third from left).

Note:  Since the recent Hordes of the Underdark expansion pack, several changes have
been made to the toolset and may not be as familiar to previous versions.

Note: Due to the large size and vast number of visual references, try opening the
documents one at a time =)
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CCCChhhhaaaapppptttteeeerrrr    1111::::

SSSSeeeettttttttiiiinnnngggg    uuuupppp    TTTThhhheeee    MMMMoooodddduuuulllleeee

With opening the NWN toolset, the default set-up is a gray and white blank
screen with a menu bar and an icon toolbar.  This chapter will introduce you to starting a
new module using the Area Creation Wizard.

Section A: The Area Creation Wizard

Step 1-To begin a new module, go to the menu heading “File” and select “New” from the
drop-down menu.  Keyboard shortcuts can help expedite menu navigation, one of which
is “Ctrl + N”, which means: hold the Control (“Ctrl”) key and press the “N”.  Using “Alt
+ F + N” will also work.  The icon that looks like a scroll on the top left of the toolbar
will also start the module wizard:

Step 2-A dialogue box, or window, appears.  Click the “Next” button at the
bottom of the window.  This window simply states that the wizard will help in module
creation.

Visual 1A-I: Reference for Step 3
Step 3- Name the module.  This will be the file
name seen in the folders or on the computer
desktop outside of this program, as well as in the
listings for existing modules once this module is
created.  The name can also be edited from within
a larger window by clicking on the small box
labeled “…” to the right of the name bar.  This
button will open a separate window and you can
even choose different languages (though this
option does not seem to work well).

Step 4-After a brief moment of initializing and loading data, the “Create Areas” box will
open.  There are no selections in the “Current areas” menu because they have not been
made yet.  To make one, click on the “Area Wizard” button in the top center of the
window.
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Visual 1A-II: Reference for Step 5
Step 5-The Names and Tilesets window now
displayed will allow you to type in the name of
a new area to be used in the module, and what
kind of tileset to use.  The wizard will continue
area creation after a name has been entered and
you have highlighted a desired tileset.

Visual 1A-III: Reference for Step 6

Step 6-In the Area Size window; the size of the
area can be incremented in undefined units.
Each square of the area can hold a single square
Feature from the landscape list.  This will be
covered later in Section C.  The best way to
gauge the size of an area is trial and error.  By
clicking on one of the four size options on the
right side of the window (tiny, small, medium,
large), you can see the numbers compared to
how the designers view the actual size.  For
example, Tiny could be considered as a small
house.  Small could be the lounge for a
respectable inn.  Medium would fit nicely for
most outdoor areas or even a castle courtyard,
and Large could be set for a small castle and

surrounding area.  Be careful, though.  The larger the area the more system resources it
will require and the slower it will perform.  If this module is for submission into an online
Mod, it is recommended not to use Large areas.  Lag is a major problem with huge
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tilesets-which can be compounded by multiple users in that same area with their actions
or spells in combat.

Step 7-By clicking on “Next” in the Area Size window, an area is finally created.  The
new “Finish” window contains two options.  “Open Area in Area Viewer” will place the
area you just created into the “Create Areas” list, which can be seen by clicking on
“Finish.”  “Launching Area Properties” will open a new window that will allow
modification of the area in detail.  This will be covered in detail in chapter **.  Leaving
the first box unchecked, and the second box checked, click on “Finish” to finalize the
area.

Visual 1A-IV: Reference for Step 8
Step 8-Now the area window is back.  The area
created from the previous steps is now listed in
the white box labeled “Current areas”.  To make
more areas using this method, click on the “Area
Wizard” button (Step 4) and continue as desired.
Otherwise, the wizard is done.  Click on the
“Next” button to finish.  The next window simply
says the area is complete.  If desired, you can
click on “Back” and return to previous steps, or
even cancel the whole thing.  By clicking on
“Finish” the wizard will close and will bring up
the main interface for the toolset.  The area
previously created with the wizard will be
activated in the main window.  The default view
for the interface is looking straight down on the
area.  In the next chapter, the interface will be

explained in detail.

Quick Summary and Review
• To make a new area, launch the Module Wizard by using the top left “New” icon

(one that looks like a scroll) in the main interface top toolbar, or using the Ctrl+N
keyboard shortcut.  Create as many areas as desired, and “finish” out of the
wizard to display the area(s).  In any one module, it can hold a vast number of
areas.

• Each area has a specific tileset, and only one area can be modified or edited at one
time.
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Section B: Considering What to Do First

Visual 1B-I: Main User Interface

• Section B-1: The Considerations

Now that the area creation wizard has finished and the window closed, the main
toolset user interface is forefront.  If the starting area chosen is the tileset “rural”, then
what is seen is much like the visual B-I.  There are several toolbars, two white columns
with lists, and the main display.  One of the first things to have to begin working on an
area is an idea of an area to build, or at least a sense of a theme.  But where to begin?

One way to start an area is to begin modifying the area with terrain and objects.
Another way to begin is to start constructing the scripts or conversations that will later be
used.  Starting with these might seem strange but it can serve to simplify or remind or
narrow the vast possibilities in the toolset.  Conversations will be explained later in detail
in Chapter 4, Section B-1, and scripts in Chapter 4.  See Script Examples for more help
on scripts, and Page of Links for additional references.  One crucial aspect of the toolset
is changing the perspective of the main display of the area to promote easy placement of
terrain and object as well as judging what will be best for the area.  Section C will go
over this in detail.
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Section C: The User Interface

• Section C-1: Changing the Perspective on the Main Display of the Area

Visual 1C-I: Main Display Navigation Bar

Though the default view of the main display is not very helpful for editing, the
angle and vantage point can be easily changed.  To change the point of view of the main
display of the area, use the buttons on the toolbar located at the bottom of the main
display.  The red arrow buttons are for vertical and horizontal shifting; see Visual 1C-II
below.  The blue arrowheads with red lines through the center are for angular
movements: the right arrow moves the display counterclockwise, and the left arrow
moves clockwise.  The blue arrows pointing up and down angle the view of the area
ninety degrees in either direction, from top view to side view, of the area; see Visual 1C-
III below.  The view will not drop below zero degrees, that is, you cannot view any part
of the underside of the tiles.  And lastly, the two magnifying glass icons zoom the main
display in or out, the red “+” or ”-” in the center of the glass change zoom level; see
Visual 1C-IV below.

Using the toolbar icons to change the view of the display is tedious and slow.
These are also meant for fast movements, and can be frustrating to use when zoomed in
on multiple levels of terrain.  Using the mouse can be far more beneficial than the toolbar
method.  Most versions a mouse are standardized with the mouse wheel, though some
older versions may not have one.  The mouse wheel can be used to zoom in and out of the
area.  Another easy method of changing display perspective with the mouse is to use a
combination of holding a keyboard button and right or left mouse button as the mouse is
moved.  Again, most mouse versions use two main buttons.  Though some have more,
they are not used.

On the end of the navigation bar, there are two other icons not before mentioned.
These are used to change the orientation of objects and creatures that have already been
placed, which will be explained later in Chapter 5, Section A-1.

Visual 1C-II: Horizontal Shift Icons

Visual 1C-III: Rotational and Angular Movement Icons

Visual 1C-IV: Zoom Icons



April, 2004 NWN Toolset Chapter 1: Setting up Your Module

Version 1 NWN: SoU, HotU 7

• Section C-2: Using the Mouse for Display Orientation

For vertical and horizontal shifting, hold down the “Ctrl” key and the left mouse
button to allow the movement of the mouse to shift in any direction.  Not only is this
method much faster than the toolbar icons, it also allows for more precise movements
instead of quick bursts of speed.  Using the mouse in this way can also allow for diagonal
movements.

For changing the angle of perspective that the blue arrows allow for, hold down
the “Ctrl” key and the right mouse button, and move the mouse.  Again, using the mouse
instead of the toolbar icons allow for a variety of direction and angles faster than could be
accomplished with the icons.

After moving and the perspective and angle of the main display, it may be desired
to reorient the view.  To do this, there is an icon in the top left of the toolbar labeled
“Reorient Camera”; see Visual 1C-V below.  To find an explanation of an icon, the best
method is to hold the mouse button over that icon, for a second or two, and then a yellow
balloon text box will appear.  This icon is the seventh from the left and looks like an eye
over a green trapezoid.  This icon is one of two icons on the Display toolbar, which can
be turned on or off by selecting Display from the View and Toolbar dropdown menu.
The keyboard shortcut is “Alt + V + T + D.”  The display toolbar is one of five toolbars
automatically shown as one toolbar upon creation of a new module.

Visual 1C-V: Reorient Camera Icon

• Section C-3: How to Place and Orient Terrain

Within each type of terrain for an area (Rural, Sewers, etc) there are specific features
and groups of features assigned.  To view the available possibilities for the terrain, the
“Paint Terrain” icon in the top right of the interface should be selected, which the default
settings will do automatically when starting a new module.  A list of three headings can
be seen to the right of the main display in a white column.  The three categories of terrain
are “Features,” “Groups,” and “Terrain.”  In each category, you can click on one of the
desired terrains and place it in the module.  The size of these terrain features or groups is
measured as the red lines of the grid in the main display.  The grid can be turned on or off
in the “Environment” section of the menu bar by selecting the “Display Grid” option, or
with the shortcut “Alt + N + D”.  If a terrain feature is chosen but then unwanted,
pressing the “Esc” key will revert the mouse to normal appearance.

The “Features” has an alphabetical list of single square terrain options.  Clicking
on one of them will change the mouse icon of an arrow into a transparent version of the
feature selected.  This can be undone by pressing the “Esc” button.  The mouse icon will
remain as the selected feature until placed in the module in a grid section that has not yet
been assigned a feature and meets the features placement requirements.  For example, the
first feature in the Rural tileset is an Anthill.  This anthill cannot be placed in water, in a
stream, in between a fence, or on a building, and other such places, and leave the terrain
as it was.  Placing an anthill in water will force the terrain into making the proper
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requirements for its placement.  Once a suitable location has been found, it can be set into
that location by left clicking.

The “Groups” section alphabetically lists features that are larger than one square.
The dimensions of the specific group are expressed as width by length.   Example:
“Barracks 1x2”.

The “Terrain” section contains basic terrain for the tileset.  The difference
between these and the “Features” section is their relation to the area.  Once selected, a
green box, instead of the actual object, replaces the mouse icon.  These green boxes will
only fit over the four corners of the grid, or in between the grid spaces.  One special
feature in this section is the “Raise/Lower” option.  This raises or lowers the terrain to
another level.  To raise ground, simply left click were desired when the option is selected
(select the option by clicking on “Raise/Lower” from the list).  Multiple levels can be
added this way.  To lower ground, right click in the desired area.  Note that the terrain
cannot be lowered beyond the initial ground level.  The “Stream” and various wall
variations appear as smaller rectangles that will only fit in between the grid sections on
the area.  The streams and walls can also merge directly into certain terrains.

Visual 1C-VI: Reference for Section C-3
For example, the “Stream”
option can appear to flow
into the forest (this also
creates an area transition on
the forest, which will be
detailed later in Chapter 6,
page 53), as well as any of
the wall variations, as seen
in visual 1C-I.

Each terrain feature, excluding those listed under “Terrain,” no matter the size,
can be oriented in four different directions with the mouse.  This can only be done when
the mouse icon has changed into the terrain feature desired, but before placement.  The
object appears transparent to make it easier to judge on appearance in the area.  To
change the orientation, simply right click once to rotate the feature ninety degrees.  Some
features will only fit certain terrain in a particular way.  If the attempt is made anyway,
each left click will show you, by outlining in a red box, which offending terrain is
responsible for not allowing the desired placement.  For example, the “Ramp” single
space feature will create a ramp from a lower to a higher-level terrain, but only with the
walkable part of the ramp facing away from the terrain (if placed in another direction, the
landscape will change to accommodate the feature, if allowed by surrounding terrain).
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To be terribly technical, the feature should be placed against the face of a cliff with the
hypotenuse of the ramp facing away from the cliff.  When terrain cannot be placed in a
specific place, the usual green box outline will turn red.  Changing direction of walls and
streams requires specific placement at different locations in relation to the grid.

Quick Summary and Review:
•  Changing the perspective in the main display of the area can be done with the

toolbar icons, or with holding “Alt” and the right or left mouse button before
moving the mouse.

• When selecting from the “Paint Terrain” list of features, some can be oriented in
different directions by right-clicking before they are placed.  Certain terrain
features require specific situations in order to be placed in an area.  Some terrain
features will alter the geography on their own when placed.

•  With multiple clicks on terrain, some change varieties and help set a different
mood.

• Section C-4: Changing Details in Terrain

In the “Terrain” list, some of the options have a special property that allows for
even more customization of a theme for an area.  This can be seen as a random
assignment of properties and features within that small section that adds to the flavor of
that area.  This randomness can be seen at the first time the new area is viewed out of the
creation wizard.  To see this change without recreating an area, select one option and
place it on the area.  Because of the nature of the “Terrain” section, the option will not
have to be selected again from the list to be places more than once.  Now, to see another
version of the same kind of terrain, left click again.  If the tileset is Rural, and the “Grass”
option chosen, each left click will slightly change the objects within the effected four grid
spaces, such as adding boulders or trees, or just plain grass.

Another way to see this effect is to select a specific grid space by left clicking on
it, which will turn the green box into a blue box outline.  By pressing the “Del” or “Esc”
key, the details will randomly change.  Yet another way is to select the “Eraser” option
and continuously left click on a terrain.  Another example is to select the “Wall 2” option
and left click multiple times in the same spot to see different conditions for the ends of
the wall.  Some terrains, such as “Wall 1” and “Stream” in the Rural tileset do not have
alternate versions, unfortunately.
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Visual 1C-VII: Reference for Section C-4
The terrain has the most basic selection of
properties to edit in the whole of the toolset.
As with most any other object, the properties
dialogue box can be accessed by right
clicking on any specific grid space.  For any
terrain, there is only one selection: “Tile
Properties.”  This opens the lighting options
for that specific grid or tile.  For basic tiles,
only the Main Light options are available to
alter.

• Section C-5: Toggling Area Shadow, Fog, and Lighting:

In addition to being able to reorient the angle of perspective in the main display,
you can adjust three other effects to better view the area in a truer light.  In the Preview
toolbar, located in the top right of the window, Display Shadow, Fog, Use Area Lighting
buttons can be toggled to display to show various aspects of the area a player will see in-
game; see Visual 1C-VIII below.  This toolbar can be accessed from View, Toolbars, and
Preview from the drop-down menu, or by the “Alt + V + T + P” keyboard shortcut.

The Display Shadow button will add shadows to every object and terrain.  Note:
sometimes shadows will stay in places where they do not belong, such as after the terrain
is moved or changed.  This can usually be fixed with toggling the shadows off and on
again.

Depending how far the Main Display is zoomed away from the area, toggling the
Fog button may seem to drown the area with single color, though the red lines of the grid
should still be visible.  The Fog button will reflect the color defined in the area properties.
See Chapter 7, Section B, for details on area properties.  The fog is best gauged from
angling the Main Display in such a way as to reflect the perspective of a player in-game.

Using the lighting of the area will enable the in-game lighting.  If in certain
tilesets, this will dramatically change the illumination level, and can hide many area
details in darkness.

Visual 1C-VIII: Shadow, Fog, and Area Lighting:

Quick Summary and Review:
• By placing the same tile or wall piece over the previous one, the new placement

will activate a random change of features for that tile or wall.  This applies only to
the features under the “Terrain” list, and even then, some do not have alternate
versions.

• To access the properties menu for most anything, right click on the desired object.
Opening this menu displays a dialogue box with the available options, the
unavailable options will be grayed-out.
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CCCChhhhaaaapppptttteeeerrrr    2222::::

NNNNaaaammmmeeeessss,,,,    TTTTaaaaggggssss,,,,    aaaannnndddd    RRRReeeessssRRRReeeeffffssss

In preparing a module for on-line submission into a Mod, it is crucial to make
sure the versions match and have the same expansion packs enabled.  Currently, there are
two expansion packs: Shadows of Undertide, and Hordes of the Underdark.  This chapter
will look at the importance of naming, and how to do it.  Another important note for
submissions to online Mods: choosing appropriate names and making sure they are
unique is required for expediency, and in some cases, acceptability.  One thing to realize,
for online submissions, is that for a similar object several people can use the same tag or
resref.  This will cause strange problems, and can hinder scripts and area transitions.

Section A: Using Names, Tags, and ResRefs

• Section A-1: Knowing What is What:
As with the creation of anything, there are details.  Regarding the Neverwinter

Nights Toolset, a critical aspect is the naming of areas, objects, scripts, and
conversations, to identify and separate their function.  They must be given a name to
identify them, not only to you, but to the system as well.

What is in a name?  In terms of the NWN Toolset, a name identifies and
categorizes for you.  See Visual 2A-I below.  The name is what a user will usually see in
both the toolset and in-game.  The actual names can be anything desired (additional
limitations may apply by designation of a Mod’s Map Master/Senior Builder/Admins/etc,
always best to ask before hand if questions arise).  There are few, if any, toolset
restrictions for what can be used for a name.

What is a tag?  Tags can usually be found under the “basic” tab in the properties
window for objects and creatures, just below the field for entering the name.  See Visual
2A-I below.  This is a hidden name for objects and creatures that will not be seen by the
players, but it is used by the toolset to identify it for use in scripts and other things.  This
could be thought of as a social security number; many people have the same name, even
middle and last names, but that number is the unique identifier for everyone.  Due to the
nature of tags, these are usually cryptic.  It is good practice, and suggested, that tags are
as cryptic as they can be to make them unique, if submitting to an on-line Mod.

Visual 2A-I: Reference for Section A: Names and Tags

What is a resref?  This is another version of a tag, and can usually be found at the
top of the “advanced” tab in the object and creature properties window.  See Visual 2A-II
below.  One difference is that the resref pertains to the basic template drawn upon for any
one thing.  Objects and creatures may have different names and tags, but they can have
the same blueprint for their creation, which is identified by the resref.  The resref cannot
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be changed after the initial creation of objects or creatures through the wizards, and it
remains grayed-out from that point on.  This can also be thought of as a restaurant food;
they all have a basic foundation or substance (being chicken, beef, etc) which various
spices and cooking methods are applied, depending on the chef.  Another difference
between the resref and both the name and tag is that the blueprint stores itself in
lowercase letters.  There are also restrictions that prevent the use of some symbols, as
well.  Another difference between the tag and the resref of a creature can be seen in
scripts.  Simply, some scripting actions require the resref of a creature, while others
require the tag (the actual name is not used in most scripts).  This will be explained later
in chapter **.

Visual 2A-II: Reference for Section A: Resref

• Section A-2: Naming Conventions:

One suggested method for making a unique Tag is to follow a naming convention.
Instead of trying to use large names or gibberish, you can always use cryptic
organization.  One method I recommend is to set the first three letters to a name you use
in-game.  Then, separated by an underscore, write the initials for the particular module,
underscore, and then the rest of the actual tag.  If you are submitting a module to be used
in an on-line Mod, it is best to ask the developer team (dev-team) if there are any
restrictions for naming conventions.  Using these conventions can help organize!

Quick Summary and Review:
• There are three kinds of identifiers for any one object or creature; name, tag, and

resref.
• The name is the identifier to be seen in-game, and has no restrictions.
• The tag is the reference label the system uses to identify the object or creature.

Duplicate tags can be problematic for scripts and area transitions.
• The resref is the initial blueprint or template of the object or creature.  Duplicate

resrefs can be problematic for specific scripts, specifically the spawning and
destruction of objects and creatures; see Chapter 4 and Script Examples for
scripting details.
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CCCChhhhaaaapppptttteeeerrrr    3333::::

IIIIccccoooonnnnssss    aaaannnndddd        tttthhhheeee    MMMMeeeennnnuuuu

The toolset Main Interface is composed of a system of icons used to expedite
navigation and help with easy shifting between options.  These icons are organized and
categorized into seven different toolbars.  By accessing the View menu and a specific
toolbar from the Toolbar option, they can be toggled in or out of hidden mode.  The
default location for five of the toolbars is just above the Main Display.  The Palette icons
are to the right of the Main Display.  The Main Display Navigation toolbar is just below
the Main Display window.  All of the toolbars can be accessed through the View menu at
the top of the window, or by using the “Alt + V” keyboard shortcut.

This chapter will also go over the details and functions of the menu options.  The
menu bar is located right above the main toolbar, which is above the Main Display.

Section A: The Icon System

This section is a brief overview of the icon toolbars and their function.  For easy
reference, each description is placed below their specific toolbars.  In the toolset, the
names for specific icons can be found when the mouse curser is placed over the desired
icon for a few seconds.  The name will appear in a yellow balloon.

Visual 3A-I: The File Toolbar

The File icons are for creating new modules, opening existing modules, and
saving current work.  The second section to this toolbar allows you to undo the most
recent change, and redoing it again if desired.

Visual 3A-II: The Display Toolbar

The Display toolbar is useful for reorienting the perspective in the Main Display.
The first button sets the view just over the Start Location.  The other button reorients the
camera to the center of the area in a top-down view.

Visual 3A-III: The Selection Mode Toolbar
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Each of the icons in the Selection Mode toolbar changes what can be selected
with the mouse or keyboard.  Selecting “Select Terrain,” the terrain can be selected and
edited with out having to select around placeable objects.  With the “Select Objects”
button, the terrain is ignored while all placeable objects and triggers can be selected.

Visual 3A-IV: The Object Filters Toolbar

Another helpful feature of the NWN toolset is the Object Filter toolbar.  By
clicking on any of the buttons in the first group of the toolbar, any objects under that
category will be toggled into or out of a hidden mode.  The pair of icons in the second
group of the toolbar are general buttons that will show or hide all placeable objects.

Visual 3A-V: The Preview Toolbar

With the Preview toolbar, aspects of the in-game quality can be viewed with out
actually testing settings with the game running.  Terrain and object shadows, area fog,
and using area lighting, can be toggled at any time.  The three green-boxed icons are
related to area background noises, area music, and placeable sound.  The Preview icon, in
the second section, displays general information about any selected placeable object.  In
the left half of the Preview window, the view of the selected object can be adjusted to any
angle or magnification.

Visual 3A-VI: The Palette Selection Toolbar

The Palette toolbar lists almost all available placeable objects and terrain for the
toolset, and allows for easy construction of custom made objects.  The first group of
icons, above the other groups, allow for the placement of terrain and the player’s start
location.  The next group of icons can display all non-terrain placeables.  The third group
of buttons will change the object listings between the Standard palette of pre-made
objects and the palette for Custom objects build for each specific module, for each object
group currently selected.  Each list will display contents by alphabetized category.
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Custom objects are not interchangeable between modules unless the correct files are
imported, which will be discussed in chapter 7, section **.

The Creature group includes monsters and NPCs.  The Door group offers wooden,
metal, and stone doors in several varieties.  The Encounter button displays the different
levels of monster groups encountered by the player.  The Items icon lists every object a
player can pick up and possibly wear or use from their inventory screen, and categorizes
them into sub-groups. The Merchants icon will display the templates for various
merchants.  The Placeable icon will display every object a player cannot pick up or wear,
such as a forge, or an obelisk, from their respective sub-groups.  The Sounds icon lists
non area specific and placeable sound files, which are also categorized into sub-groups.
The Triggers icon includes traps, area transition fields, and triggers for special effects that
can be scripted.  The Waypoint icon displays placeable waypoints and in-game mini-map
notes for the player.

Visual 3A-VII: The Main Display Navigation Toolbar

The Main Display Navigation icons reorient the Main Display.  The red icons
shift the display in latitude and longitude.  The blue icons change the perspective angle.
The magnifying glass icons adjust the level of zoom.  The last pair of icons adjusts the
orientation of non-terrain objects by clockwise and counterclockwise movements.
However, for more precise and more efficient methods of orientation in the Main
Display, please see chapter 1, section C-1.

Section B: The Menu Options

Visual 3B-I: The Menu Bar

The menu bar is a list of options using text, and is located above the main toolbar.
There are eight options to choose from to help modify your module and access certain
features.  Some of the options have an icon shot cut in any one of the toolbars, which is
displayed next to the option.

The File Menu Bar Option: “Alt + F“
•  The File options let you create new modules, open others, or close the current

one.
•  The next group of options lets you save your work under the current save file

used, or to create a new file to save to with the “Save As” option.
•  A way to transfer pre-made material to and from your module is to use the

“Import” and “Export” options.
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• The toolset will also list the four most recent modules, and allow you to switch to
them as a shortcut.

• The last option is “Exit”, which will prompt you to save any new work and close
the program.

The Edit Menu Bar Option: “Alt + E“
• The pair of choices in the first group allow you to undo or redo edits.
• As with most any interface, you can use the options to delete something from the

area and add it to the copy/paste clipboard.  You can use the options to copy and
paste as well, or use the “Alt” and “C,” “X,” or “V” key keyboard shortcuts.

• The Resize option will add rows or columns, or even take them away if desired.
You can also rotate the area with the Rotate option, which will bring up a separate
window with several choices where direction and degree of turn can be specified.

Visual 3B-II: Menu Bar: Edit: Find Instance Window:

•  The “Find Instance” option
can be used to find a
particular object or creature
in a specific area.  A separate
window will open, allowing
you to set additional search
conditions.  Under the
“Search For” box, you can
select any number of object
categories to limit the search.
In the “In Area” drop-down
menu, you can select which
area in your module to
search.  One of the  “From
Blueprint” and “With Tag”
fields can be specified, but
both do not have to be

entered to start a search.  Once all the parameters are set, click on the “Search”
button at the bottom.  Any matches will be listed in the bottom half of the
window.  If there is one match, that object will also be highlighted in the Main
Display when the Find Instance window is closed.  You can also clear the current
search parameters by clicking on the “Clear” button in the center right of the
window.

•  The “Module Properties” and “Area Properties” open separate windows with
various options to edit.  The module and area properties options will be covered in
detail in Chapter 7.

The View Menu Bar Option: “Alt + V“
• The “Selection Mode” option allows you to change between effecting terrain or

objects in the Main Display.
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• The “Toolbars” option will hide or unhide any of the five main toolbars that are
located just above the Main Display.

•  Selecting any of the “Interface Panels” options will hide or unhide a specific
section of the toolset interface.

• The “Object Filters” options will hide or unhide all objects related to the specific
group chosen.  See Visual 3A-IV above, in Section A of this chapter, for the
toolbar icons that will do the same thing.

•  With the “Full Screen” option, you can fill the Main Display to your entire
monitor, and back again with the “F11” key

•  The Preview window is a superimposed dialogue box that will give basic
information about a creature or object highlighted.

The Environment Menu Bar Option: “Alt + N“
•  Refresh option will reset the current visual aspects of the area to include the

current setup.  While changing the geometry of an area, shadows might not apply
to certain areas.  Refreshing the area will allow the toolset to verify and adjust
such things.

• Toggling the Grid option will show or hide the red grid lines of an area.
• Displaying the shadows of an area can give you another perspective on the area.
• The area fog exists in-game regardless if any is desired or not.  This fog will be

visible in the toolset, and will appear in-game as a the players visual threshold.
With the current Hordes of the Underdark expansion pack, this zoom feature is
automatic.  In previous versions of NWN, a command would be required in the
console.

• To view the area with the lighting that will be used in-game, toggle the “Use Area
Lighting” option.

•  In the NWN game, when a player passes certain terrain features, part of those
features will disappear.  This is fading of the geometry is a necessity for the third
person perspective used in-game.  This feature can also be used in the toolset by
toggling the “Fade Geometry” option.  In this option there are three choices,
“Always,” “Object Move Only,” and “Never.”

• By toggling any of the three sound buttons, they will begin or end their specific
track and kind of music or sounds.  Ambient sounds can be considered
background noise.  For cities, the ambient sounds could include conversations,
distant cries, bells, etc.  The background music is the themed music for the time or
specific tileset.  Activating placed sounds will play the sound files placed within
the area, but the toolset perspective must be close enough to the effective range of
the sound file, which is explained in detail in Chapter 6, Part 2.

The Build Menu Bar Option: “Alt + B“
• The “Verify Area” option will tell the toolset to examine your area and let you

know of any “Inaccessible Objects” that might cause problems.  A list of the
objects will appear in a separate pop-up window.  Taking care of the problems
that are present in this window is not required for the module to run, but it is
recommended.
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Visual 3B-III: Environment Menu: Build Area Window: Advanced Options:

• The “Build Area” option
is recommended use to
finalize and perfect your
module.  This option
will tell the toolset to
verify the area and
search all the resources
of your module and
display anything that
could use attention.
Selecting every option
available, the “Results”
section will notify you
of various things,
i nc lud ing  unused
resources, scripts, and
even object blueprints.
This is one way you can
search your module for
certain things.  For
example, when I submit
modules, or start to test
them out myself, I
include an amulet called
“haste” that imbues the
haste spell when worn at

the start point for an area.  Having haste while walking through areas can help
expedite evaluations.  It is important for people to test areas with a player
character rather than a DM character because of the simple reason that DM
characters do not set off triggers, hence the amulet to make up for the loss of the
DM speed.  If I have tested an area and wish to send a final version of it to the rest
of the development team, I would not include the haste amulet.  As you can see in
Visual 3B-III, in the middle of the “Results” section, I now know that the haste
amulet is not in the module because of the “Unused item blueprint: haste”.

• Selecting “Area Statistics” will open a small window that will display how much
space the area uses in terms of kilobytes.  It will also break down this information
in to “Model” and “Texture”.

The Tools Menu Bar Option: “Alt + T“
• In the Tools menu there are four Editor shortcuts available, Conversation, Faction,

Script, and Journal.  Selecting any of these will load the respective Editor in a
separate window.

• The “Options” selection will open the modules detailed option window.  In each
of the six groups of options, General, Area, Script Editor, Conversation Editor,
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Sounds, and Language, there are various self-explanatory options that can be
toggled and set.

The Wizards Menu Bar Option: “Alt + W“
• This menu option allows you to select any of the module wizards.  For full details

and several walk-throughs of these programs, please see chapter 4.

The Help Menu Bar Option: “Alt + H“
• The “NWN Web” option will open Explorer and link you to an outdated web page

no longer used.  The web page Bioware now uses is http://nwn.bioware.com
•  Selecting “About” from the drop-down menu will open a separate window and

display which expansion packs are installed and the “End-User License
Agreement” terms

Quick Summary and Review:
• NWN toolset employs a system of icons to help make the toolset easier to use.
• Each toolbar can be hidden or shown through the View menu option.
•  Each section of the Main Interface can be hidden or shown through the menu

option
•  Certain features in the toolset will help you to perfect your module, such as

“Build Area”.
• More help can be found at the Bioware home page, including forums.

http://nwn.bioware.com


April, 2004 NWN Toolset Chapter 4: The Wizards and Editors

Version 1 NWN: SoU, HotU 20

CCCChhhhaaaapppptttteeeerrrr    4444::::

TTTThhhheeee    WWWWiiiizzzzaaaarrrrddddssss    aaaannnndddd    EEEEddddiiiittttoooorrrrssss

This chapter will examine the aspects of a Wizard and how to use one for creation
of various objects and creatures for your module.

Section A: What is a Wizard and How is it Used?

A Wizard is a program in the toolset that will guide you through a specific
process.  There is one specific Wizard for each of the nine different placeables in the
Palette.  Right clicking on any Palette list under the “Custom” button, and selecting
“New” from the pop-up menu, will run the Wizard for the placeable type selected.  In the
visual below, the “Monster” button and the “Custom” button are selected, and selecting
“New” will start the Creature Creation Wizard.  For details on the Plot Wizard, please see
the NWN Vault at http://nwn.bioware.com/builders/plotwizard_tutorial.html

Visual 4A-I: Reference for Section A: Starting A Wizard:

• Section A-1: Walk Through of the Creature Creation Wizard:

Step 1:  The first screen of the new window will let you know which Wizard it is.  You
can continue by clicking on the “Next” button, or exit the Wizard.

Step 2:  The Wizard will ask you to choose what racial category out of 25 your creation
will belong to.  Click on “Next” when one is highlighted.  In the next step, your creature
will be given a 3D model as an example of the race, which can be moved in any direction
with either mouse buttons and the mouse wheel.

http://nwn.bioware.com/builders/plotwizard_tutorial.html
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Visual 4A-II: Reference for Section A-1: Step 3:

Step 3:  This step will
allow you to add two
other classes to the
creature.  Each of the
38 classes can be
adjusted up to level
40.  Unfortunately, at
this point the creature
may not meet the
requirements for
certain classes, such
as Assassin.  To add a
class, highlight it and
click on the “Add
Class” button, or
simply double click

the class.  If you want to remove a class, click on the red “X” box to the right of the Level
column.  If you want to add a class that is beyond the creature’s current proficiencies, that
can be done later in the Classes tab of the Creature Properties window, which is
explained in chapter 5, section B.

Step 4:  In the next window, you can select your creature’s gender, appearance, and
portrait.  The appearance drop-down menu has an extensive alphabetical list of every
creature used in the game.  One of the appearances not available in the Standard Palette
list of creatures is “Mephistopheles,” and “Mephistopheles, Large”.  You can change the
portrait of your creature by clicking on the “Portrait” button, or double clicking the actual
portrait, which will open another window that will allow you to search through every
portrait in the game, depending on the limitations specified in that same window.

Step 5:  The next step is to assign your creature’s faction.  There are four basic factions
to choose from, Hostile, Merchant, Commoner, and Defender.  Any custom made
factions for this module will also be present here.  These factions will determine your
creature’s attitudes towards the player and other creatures in-game.  Hostile creatures will
attack the player(s) and other non-Hostile aligned creatures, and represent what most
humans call the “evil” part of the world.  Merchant, Commoner, and Defender factions
are neutral or even friendly towards player characters.  Factions will be explained in more
detail in Creature Properties, which can be found in Chapter 5, Section B.

Step 6:  This next window has one field and asks you to enter the creature’s name.  This
name will also be translated into the “Blueprint ResRef”, which will be in all lowercase
letters with no spaces, but only includes the first 16 characters or numbers.  It is
recommended to consider this field as the request for the resref, if only because changing
the resref later requires extra steps than changing a Name or Tag.  For an explanation and
suggestions on naming conventions, see Chapter 2, Section A-2.
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Visual 4A-III: Reference for Section A-1: Step 7:
Step 7:  “Select
Palette Category” will
ask you where to
place the creature in
the “Custom” creature
palette lists.  To easily
find your creature
later, I recommend
putting the creature
under any of the
“Special” categories.
However, for online
submission, it is best
t o  a s k  t h e
development team if
they  have  any
preferences.  If every

builder stuck their custom creatures in the “Custom” slots, DM’s might have trouble
selecting creatures for specific in-game things if the only reference for the creature was
the name.

Step 8:  This window displays a general review and summary of the creature, including
challenge rating, and scripts used.

Step 9:  The Wizard is now complete, and the creature will be created in the Palette when
you click on “Finish.”  You also have an option to check the box “Launch Creature
Properties” on exit of the wizard.  This will open the detailed properties for your creature
in a separate window.  For an explanation of the Creature Properties window, see Chapter
5, Section B.
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• Section A-2: Placeable Creation Wizard Walk Through:

Visual 4A-IV: Reference for Section A-2: Step 1:
Step 1:  The first screen in the new
window of the Wizard will ask you
to select a category to set your
object under when it is created.
This will be true for all Creation
Wizards, and will be the first step
of most of them.

Step 2:  Next, you will be asked to
name the placeable.  As with the
Creature Wizard previous, it is
recommended to consider this
prompt as the request for the resref
of the placeable.

Step3:   This is the end of the
Wizard.  Editing this placeable will
require you to right click on the
object and select “Edit” from the
pop-up menu.  Object and Placeable

properties will be covered in detail later in Chapter
6.
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Section B: The Editors

Another aspect of the toolset is the collection of Editors.  There are four editors
that can be accessed from the Tools menu bar, Conversation, Faction, Script, and Journal.
Each Editor can be found through other various menus and options.  Selecting any of the
four from the Tools menu bar will open the Editor in a separate window.  Because these
tools are not designed like Wizards, you will not be given the same level of help, such as
prompts and step-by-step methods of editing.

• Section B-1: The Conversation Editor

Visual 4B-I: The Conversation Editor Window:

One of the quickest ways to start using the Conversation Editor is to right click on
any existing conversation and select “Edit,” or right click on the Conversation group of
the Module Content Interface Panel and selecting “New” from the pop-up menu to start a
new file.  The “Module Contents” section is located on the left side of the Main Display.
If it is hidden, you can unhide it from the View menu bar by selecting “Interface Panels”
and “Module Contents”.  This list contains all objects, creatures, conversation, and scripts
for the currently selected area.

Once in the Conversation Editor with a previously written conversation, the
screen may look much like Visual 4B-I above.  There are three main sections to the
editor.  The top half consists of three toolbars and a display of the conversation tree.  The
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bottom half has two sides.  On the right are the Text and Speaker details.  The left side
has extra options that can be chosen from several tabs.

• Top Half of the Editor:
The top right horizontal toolbar has two groups to it.  The left half holds the “New,”

“Open,” “Close,” “Save,” “Save As,” and “Options,” buttons.  The “Options” button will
open another window with details and text color options.  The second group will
highlight various aspects of a conversation, such as sounds or animations.  See Visual
4B-II below for reference.

Visual 4B-II: Conversation Editor: Top Half Horizontal Toolbar:

Visual 4B-III: Conversation Editor: Top Half Vertical Toolbar:

• Adds a line of text under the currently selected line
• This button copies a single line to the clipboard

• Cuts the currently selected line out of the conversation tree
• This button pastes a copied line to the bottom of the current column

• Opens a separate window to search for specific text
• This will search for the next occurrence of specified text

• This search will expand to other files
• This is a search and replace text button

• This button will expand the conversation tree completely
• The last button will close the tree to one line

Under the display for the conversation tree is a text bar that shows word size and
other data about the conversation, much like Visual 4B-IV below.

Visual 4B-IV: Conversation Editor: Conversation Data:
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• Bottom Half of the Conversation Editor: Data Tab:

In the bottom right of the window, there are three tabs to choose from, “Data,”
“Bookmarks,” and “Search.”  Of the three, “Data” is the only one I have found a use for
so far.  In the drop-down menu of the “Speaker Tag,” you can select the tag for the
creature who will speak the text in the box below.  The text of the line can also be edited
from the large box.

On the left side are other options with five different tabs for selection.
• “Text Appears When” will allow you to set a script as a condition for the text to

appear, but can also work in conjunction with the point in the conversation.
•  “Actions Taken” will fire a selected script after the conversation reaches that

point in the tree.
•  “Other Actions” will open the actions of the conversation to playing certain

animations for the speaker, play a sound, or even activate the journal.
• “Comments” is a simple field to place any desired comments.
• “Current File” offers more scripting options, along with a “Camera Zoom” feature

that is activated by default.
As with most script selection fields, the “…” button will display a list of all scripts

constructed in the module, instead of choosing a particular script from hundreds in the
drop down menu.

• Section B-2: The Script Editor

This editor is basic, as seen in Visual 4B-V below, but comes organized into
categories and lists all available material.  The top right toolbar has the standard “Save,”

“Save As,” etc, options.  The “Save and Compile” button  on the far left of the top
toolbar will save the script, or open a new window for you if it is a new script to save as,
and then compile the script.  When a script compiles, the toolset constructs the script into
actions it will perform.  If there are any errors found, the script will not be usable.  It will,
however, list the errors in a screen at the bottom of the window, letting you know where
to find them.

Another useful feature is the “Bookmark” button .  When the curser is on any
line in the main display of the script, pressing this button will copy that line to the
window below the main display, which can then be viewed by choosing the “Bookmarks”
tab at the bottom of the window.

On the right hand side of the Script Editor is a listing of all the available aspects
of the NWN toolset scripting previously used in the game.  They are organized into
“Functions,” “Variables,” “Constant,” and “Templates.”  You can also search any of
these four categories for a specific word or letters by typing into the “Filter” field above
the lists.  Clicking on any of the listed names will display an outline for that subject in the
window below the main display in the “Help” tab.

• For more details on scripting, please see Scripting Examples.
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Visual 4B-V: Script Editor Interface:

• Unfortunately, I have not used the Journal Editor.  You can visit the NWN
Bioware web page for a large forum that may answer other questions.

• For details on the Factions Editor, see Chapter 5, Section B, Page 34.

Quick Summary and Review:
• Every aspect of the toolset has a Wizard or an Editor to help you through the

creation process.
• The Wizards and Editors can be accessed through the menu bar or by right

clicking in certain fields of the Main Display and Interface Panels.
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CCCChhhhaaaapppptttteeeerrrr    5555::::

CCCCrrrreeeeaaaattttuuuurrrreeeessss    aaaannnndddd    NNNNPPPPCCCCssss

Section A: Selecting and Placing

This chapter will cover creatures in detail, going over creation and editing with the
property tabs.  Each tab will also be explained in detail with visual references.

• Section A-1: Selection and Placement of Creatures:

Visual 5A-I: Palette Menu:

After selecting the red icon on the Palettes menu , two headings appear
under the “Standard” option: “Monsters” and “NPCs” (see Visual 4A-I above).  Clicking
on the “Monsters” heading will show 13 other alphabetized sub-categories of creatures to
choose from; Aberrations, Animals, Constructs, Dragons, Elementals, Giant, Humanoid,
Insects, Magical Beasts, Miscellaneous, Planar, Shapechangers, and Undead.  Clicking on
any of these sub-categories will show the names of all creatures in that category available
for placement.  For one or two hidden appearances, see the Hits and Tips section under
“Secret Appearances”, or see Chapter 4, Section A, Step 4, of the creation wizard for
objects.

Visual 5A-II: Standard and Custom Palette Selection Buttons:

Standard Palette?  This is a list of pre-made material provided by the toolset (all
of which have been used in the game at some point).  Right clicking anywhere on the
names in the Standard Palette with open the “Find Text” window.  This window will
allow you to input a name or group of words to search for from any list in the Standard
Palette.  If the search found what you entered, it will take you to it, even if the target is
outside of the current type of objects (creatures, waypoints, merchants, etc).

Custom Palette?  Selecting “Custom” will show the list of user-defined objects.
Obviously, if you have not made anything, nothing placeable will be shown.  To create a



April, 2004 NWN Toolset Chapter 5: Creatures and NPCs

Version 1 NWN: SoU, HotU 29

custom creature or object, right click on any of the categories under the “Custom”
listings.  A separate window will open.  This new dialogue box will be a Creation Wizard
for the particular category selected (see Chapter 4 for more details).  Once done with the
creation wizard, the newly created object will appear under the “Custom” listings.  It can
now be placed into the module.

What’s the difference between a “Monster” and a “NPC”?  A monster is the
classic example of an adventurer’s diet: experience.  These are things for the player to
destroy or overcome, while “NPCs” (non-player characters) are usually friendly or
neutral humanoid characters, such as elves, or dwarves.  However, this does not mean the
friendly creatures in the game are limited to the creatures in the “NPC” lists.  Any
“Monster” or “NPC” can be set to interact with the player in any mood or level of
hostility; one method to change creature/player relations is to edit faction, which will be
covered on page 34.

To place anything from the “Standard” Palette into the area, simply left click on
the name.  As with terrain features, back in chapter 1, the mouse icon becomes a
transparent version of the object selected, for most Palettes.  The default stance for any
creature placed is a “flat footed” or the “at rest” pose.  In the properties window for
creatures, the creature animation continues until the window is closed.  Once placed, the
creature animation does not continue.  The creature or object can be rotated to face any
direction, by using the clockwise and counterclockwise buttons, located on the Main
Display Navigation toolbar (see Visual 4A-III below)

Visual 5A-III: Creature/Object Rotation Buttons:

Quick Summary and Review:
• The Palette consists of two types of objects: “Standard” and “Custom”.
• The “Standard” Palette lists all placeables previously used in the NWN game
• The “Custom” Palette lists all placeables you have created for the module
• The ten different Palette categories, from terrain to waypoints, can be viewed by

choosing their respective icons.
• You can “Import” and “Export” any placeables and scripts, labeled by the toolset

as a Resource for the module, in between various other modules.
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Section B: Creature Properties Window

• Section B-1: Monster Property Tabs:
Once placed into the module, you can edit the properties of each creature.  To

view the “Creature Properties” window, right click on the desired creature in the Main
Display, and select “Properties” from the pop-up menu.  In this window, there is far more
details than one window alone can display.  To navigate between the different categories
of properties, select the appropriate tabs in the top right of the window.  To edit the
inventory of the creature, click on the “Inventory…” button below the Creature Display
on the left.

Visual 5B-I: Monster Properties: Tab:

Basic Tab Group: Profile:
•  The First Name and Last Name fields are seen by the players in-game.

Specifically, the First Name only will appear next to portrait listings of group
members.  The First Name and Last Name will appear when the player moves the
mouse over the target, or presses the Tab key.

• The Tag field allows you to change the Tag quickly.  The button at the end of the
Tag field assigns a unique tag automatically.
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•  The Race drop-down menu assigns a particular race to the creature.  This is
important to define, as some weapons have greater effects against certain races.

• Phenotype is a special field for advanced builders.  It appears this may require hak
packs, but can be rewarding.  The Bioware forums can be more helpful on this
subject in implementation and uses.  One such thread can be viewed at
http://nwn.bioware.com/forums/viewtopic.html?topic=338651&forum=48 .

• The Gender field assigns Male, Female, Both, Other, and None.
• The Description of the Creature is the text that will appear in a separate in-game

window when the creature is examined.  The field is only one row wide.  To edit
the description in a larger window, click on the “…” box at the end of the field.

• A Challenge Rating describes the overall power of the creature in relation to the
player, taking into account: statistics, spells, feats, and equipment.  Or, in other
words, it is a gauge of   strength or power required to defeat the creature.

Basic Tab Group: Portraits:
•  Clicking once on the current portrait will open another window for even more

options and easy navigation for selecting a specific portrait; see Visual 4B-V
below.

• Clicking on the “…” box next to the grayed-out field with the name of the portrait
will

Basic Tab Group: Conversation:
• This drop-down menu allows you to select a specific conversation from a list of

pre-written files.  This list includes every conversation used in NWN.  To find a
list of conversations created by a user of the toolset, click on the “…” button.  To
enter the conversation editor, click on the “Edit”

http://nwn.bioware.com/forums/viewtopic.html?topic=338651&forum=48
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Visual 5B-II: Monster Properties: Basic Tab: Portraits:

Basic Tab Group: Portraits: Portraits Window:
• This window allows for a specific display of certain portraits.  By selecting one of

the three groups, Characters and Creatures, Plot Characters, or Placeable Objects
and Doors, portraits specific to those groups will appear in the white box below
the options.  The Characters and Creatures group can also sort portraits by race or
gender.  To select a desired portrait, click on one of the available portraits in the
white field below the options.  A blown up version of the portrait will appear on
the left side of the window.
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Visual 5B-III: Monster Properties: Advanced Tab:

The Advanced tab begins by displaying the “Blueprint ResRef”, which cannot be
changed, but is assigned at creature creation with a Wizard; see Chapter 4 for the
Creature Creation Wizard)

Advanced Tab Group: Interface:
• There are several boxes that can be checked to add or remove properties for the

creature: Disarmable, No Permanent Death, Plot, Immortal, Leaves Lootable
Corpse.

•  Disarmable means the creature can be disarmed by a player succeeding in a
disarm check against it.  It is recommended to keep in mind the disarm question
when considering to allow a gnome or small player to disarm a giant.

• The Plot selection will render any attempt to harm the creature utterly ineffective.
• No Permanent Death
•  Being Immortal grants the creature safety from dying.  No matter how much

damage the player does to it, the creature will live on.
• When choosing if the creature should leave a lootable corpse, you can set Corpse

Decay Time in units of seconds, as well as choose which Treasure Model from
many out of a drop-down menu.
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Advanced Tab Group: Faction:
•  A faction is an affiliation that has specific relations to other factions.  Every

creature has a faction.  The drop-down menu has a small list of the current
available factions.  If desired, a new faction can be created and tailored to
complicated relations.  To begin the creation of a new faction, or to view the
details on existing factions, click on the “Edit Factions” button.  This will open a
new window; see Visual 4B-VII below.  Advanced Tab continues after Factions
are explained, below Visual 4B-VIII.

Visual 5B-IV: Faction Editor: Basic Tab: Full Detail Mode:

Creature Properties: Advanced Tab: The Faction Editor: Full Detail Mode: Basic Tab
• To engage the “Full Detail” mode of the faction editor, check the “Full Detail”

box located in the bottom right of the window.
•  Click on one of the factions listed in the white box on the right side of the

window.  Note that the faction PC cannot be selected as it is for comparison only.
• The Faction Editor shows a bar graph displaying the PC’s relation to each faction

and again with the highlighted faction in relation to the other factions.  The Y axis
gauges the relation towards friendly or hostile by numbers, 0 to 100, 100 being
friendly.  The X axis lists each faction by name.

• In the Visual 4B-VII above, the faction highlighted is the Commoners.  For each
faction, other than the PC, two vertical bars will appear.  The first bar shows the
relation of the chosen faction to the faction of the particular column.  The second
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bar shows the relation of the faction in the particular column in relation to the
chosen faction.

• The thick red horizontal bar at the bottom of the display, and the blue bar at the
top of the display, indicate precisely when a faction will enter hostile or friendly
relations.  If a faction is set anywhere in between these factions, they are neutral
to the respective affiliations.

• For example, clicking on the first vertical bar in the Merchant column will post
text just below the display; “Commoner is neutral toward Merchant” because the
first bar is at the neutral, or 50, mark.  The lower the first bar goes toward hostile,
or 0, the redder it will become, vise versa towards friendly, or 100.  The second
bar will post the text “Merchant is neutral toward Commoner” just below the
display, which effects the Merchant affiliated NPC’s reaction on detection of the
NPC(s) affiliated with the Commoner faction.

• The bars can be adjusted as desired by click and holding the mouse icon over one
of the vertical bars.  Note that, to make one faction hostile to another, the hostility
is not reciprocated unless you specify by adjusting the appropriate bar.  For
example: moving the first bar in the Merchants’ column to hostile, or 0, will
change the Commoners’ reaction to the Merchants from neutral to hostile, but the
Merchants are still hold neutral relations to the Commoner faction.  What will
happen in-game will be every Commoner affiliated NPC will attack every
Merchant affiliated NPC on sight, but the Merchants will not attack the
Commoners.

• If desired, a faction can be set to be hostile towards its own members by adjusting
its own column to hostile.  Note that adjusting either bar in the same faction as the
highlighted faction will cause both bars to move simultaneously.
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Creature Properties: Advanced Tab: The Faction Editor: Advanced Tab:
• The Advanced tab shows the same faction information as the Basic tab, but with

cells organized in rows and columns; see Visual 4B-VIII below.  The rows show
the actual faction, and each column shows their relation to that column’s faction.
For example; in Visual 4B-VIII, the Commoner row shows that they are friendly
to each other, and neutral to the Merchant faction.  The first cell, in the first row
and first column, shows the faction’s relation towards itself and appears as a
lighter shade compared to the other colored cells.

• Highlighting any one faction will not show any relation other than to itself.
• To see the relations between two or more factions, click and drag over the desired

factions.
• To select specific factions, hold the “Ctrl” key and click on the desired factions.
• Friendly factions will be colored blue, neutral gray, and hostile are set to red.
• Clicking on the desired cell and editing the value can change the relations to other

factions.

Visual 5B-V: Faction Editor: Advanced Tab:
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Monster Properties: Advanced Tab Continued: Advanced Tab Group: Special:
• The Special group allows you to assign a sub-race and deity.  These sections used

more of as a note to other people viewing this creature than setting actual
properties or effects.

Visual 5B-VI: Advanced Tab: Sound Set:

Advanced Tab Groups: Sound Set:
• Choosing a sound set gives the creature more

life to it.  To change the sound set, click on the
“…” button to the right of the Sound Set.  This
will open a separate window that lists all the
available sound sets; see Visual 4B-IIX.

• To help narrow the selection, you can choose
to display male or female voices only.

•  Further options are available from a drop
down menu to help narrow the selection.

• Clicking on one of the listed names will play
the first in a number of sound files linked to
that voice.  Clicking multiple times on one
voice set will continue down a list of files for
that voice.

Advanced Tab Groups: Perception Range and Challenge Rating:
• The Perception Range is the level at which the NPC or creature will be able to

detect a player or other creature, and respond according to faction settings.  The
range of perception is Short, Medium, Long, Default, which can be selected from
a drop-down menu.

•  In the Challenge Rating group, there are three display boxes: Calculated,
Adjustment, Challenge Rating.

•  The Calculated box shows the toolset’s guess on the creatures CR (Challenge
Rating) based on the creatures unique properties and equipment.

• The only box of the three that can be edited is the Adjustment, which will add or
decrease CR points when any are assigned by clicking the up or down arrows, or
by entering a value in the field.

• The Challenge Rating box displays the current CR, adding both the Calculations
and Adjustment boxes together.
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Visual 5B-VII: Monster Properties: Statistics Tab:

Statistics Tab: Ability Scores Group:
• Each feature of a creature can be categorized under one statistic.  These statistics

are the foundation for most RPGs (Role Playing Games) characters.
•  Strength governs physical prowess and is associated with melee damage and

maximum weight carried.
•  Dexterity is the emphases for speed and reflexes, and adds to the armor class

rating.
•  Constitution determines the strength of body, usually regarding resistances to

poisons or disease.
•  Intelligence and Wisdom are interchangeable concepts, and the only pair of

statistics that are not universal in understanding and use between different games.
For Neverwinter Nights, Intelligence is a measure of understanding information,
such as magic, and how well one can process it.  Defined in the NWN character
creation menu in-game, the Wisdom score governs a character’s common sense,
willpower, perception, and intuition, and is used in a variety of ways.

• Charisma describes the level of physical charm other players and creatures see,
and is, oddly enough, a primary statistic for some classes.

• These statistics can be modified in the white Score column with the up or down
arrows next to the field, or by manually entering a value.

• The three columns to the right of the Score are Racial Modifier, Total, and Bonus.
The Racial Modifier pertains to special conditions for each race.  For example, the
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halfling or gnome races have a maximum strength cap that is below the cap for
orcs.  This is a limit designed to set races apart from each other with bonuses and
weaknesses for choosing a particular race.  This is also what diversifies the world,
and adds to the balancing of races in relation to each other.  In most games,
including NWN, statistics are in comparison to human standards.
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Visual 5B-VIII: Monster Properties: Feats Tab:

Every player and creature in the game has a list of available skills, which are
called Feats.  In the “Feats” tab in the Creature Properties window, you can assign
specific feats to a creature.  You can also set a filter for the list, rather than displaying the
hundreds of available Feats in the game.  The “Feats Selection Summary” window
categorizes all feats the creature is granted into their respective groups.

Monster Properties: Appearance Tab:
Monster appearance cannot be modified for pre-made creatures on the “Standard”

Palette.  To fully customize your creature, you will have to create a new creature/monster
by changing to the “Custom” Palette, right clicking on anything in the list, and selecting
“New” from the pop-up menu.  See Chapter 4, Section A, for more details in the Creature
Wizard.
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Visual 5B-IX: Monster Properties: Spells Tab:

Creature “Spells” tab displays the creature’s current available spells for use and
the level of any particular spell to be used.  The first display simply lists every spell
available in the game, and the relation, if any, to the creature.  The numbers can be
modified by clicking in the “Prepared” column for the row of any particular spell.  For a
creature to be able to use spells, one of the three classes a creature has must be able to use
magic, such as Wizard or Cleric.  If the creature does not have any class capable of using
spells, you can go to the “Classes” tab and add any desired magic-user class, as explained
under the next Visual.  You can change which class spells to use by clicking on any of
the three classes listed in the “Class” group in the middle of the “Spells” tab window.

You can also filter the levels with selecting the desired level from the drop-down
“Spell Level” menu.  The “Meta-Magic” drop-down menu will also list other higher-level
powers of magic.  At the bottom of the window, there are three buttons to do quick
changes.

• “Clear Class Spell List” will clear the list.
•  “Save Class Spell List” will open another window for you to save the current

selection to file.
• “Load Class Spell List” will allow you to load a previously saved spell list for the

creature.
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Visual 5B-X: Monster Properties: Classes Tab:

This tab edits the “Alignment,” “Classes,” and the preferred structure for leveling
up the creature.  All three groups use the drop-down menus, and the “Classes” group also
allows you to adjust the level of each particular class assigned to the creature, to a
maximum of 60 for each class.  Note: in-game players can only level up to 40 with the
recent expansion pack.

Once you have selected the classes to be used, and assigned levels, choose a
desired “Package” from the drop-down menu “Default Package for Autolevelup.”  This is
a focus for points and skills during every level-up distribution.  The last step to actually
setting these skills for levels is to click on the “Levelup Wizard” button, which will
automatically level-up the creature with out any further requirements.
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Visual 5B-XI: Monster Properties: Special Abilities Tab:

This tab is similar to the “Spells” tab in that it will allow you assign special
powers and skills for use in-game.  You can adjust the level of power and the number of
uses of that power.  You can also set different filters from the drop-down menu below the
display.  A summary of the creature’s powers will be shown at the bottom of the window.
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Visual 5B-XII: Monster Properties: Skills Tab:

The “Skills” tab will allow you to adjust the creature’s skill categories, to a
maximum of 99.
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Visual 5B-XIII: Monster Properties: Tab:

The “Scripts” tab allows you to assign different scripts to a wide variety of
circumstances, such as “OnSpawn,” or “OnDamaged.”  You can choose from a list of
every custom and default script in the toolset from the drop-down menu.  By clicking on
the “…” box to the right of each field, you can access a list of every script created for the
currently opened module.  The “Edit” button will launch the editor with a blank screen,
or with a currently selected script in the field.  You can also save the specific script setup
with the “Save Script Set” button.  You can load other script sets with the “Load Script
Set” button near the bottom of the window.

Monster Properties: Comments Tab:

As the tab describes, simply a blank page to put any comments about the creature.
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• Section B-2: Creature Inventory:

The “Inventory Contents” window is broken down into four different sections.  See
Visual 4B- below.

o  The “Standard/Natural Equipment” tabs will allow for placement of
various items in their proper slots, in the top left of the window.  When the
“Standard Equipment” tab is selected, you will see the same equipment
screen as the in-game player inventory.  To equip an item into a particular
slot, you must use the drag and drop method from the Palette lists on the
right.  If the creature does not meet the requirements for the item, the
toolset will allow you to assign them from this screen, rather than having
to exit back to the “Feats” tab and assign them yourself.  Items can be
double-clicked in the Palette lists to appear in the “Contents” group below
the inventory display, and placed from there as well.

o  The “Standard/Custom Items” tabs allow you to choose items from the
“Standard” or “Custom” Palette.  You can also select the “New” button to
launch the Items Creation Wizard.

o The “Contents” group displays the inventory held by the creature that are
not actually being used.

o The last group is the “Options” for the creature.  This section allows you
to assign the “Dropable” or “Pickpocketable” options for each item worn
or held.  As I understand it, items marked “Plot” cannot be stolen.  I have
not tested this with “Plot” items marked “Pickpocketable” to see if they
can still be stolen, however.

o  Each item in the “Contents” or “Equipment” groups can be edited by
right-clicking on the item.  This will open the Item Properties window,
which will be covered later in Chapter , Section .

• Section B-3: Creature Inventory: Natural Equipment:

o  The “Natural Equipment” tab can be used for any creature to assigning
special attacks, such as clawing or biting weapons, and to define natural
armor.  See Visual 4B- below.

o The only items that will be allowed in any of the three weapon slots or the
armor slot are those selected from the sub-categories under the “Creature
Items” Palette list.  These slots are not required, though.
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Visual 5B-XIV: Monster Properties: Inventory: Regular Equipment:

Visual 5B-XV: Monster Properties: Basic Tab: Inventory: Creature Equipment:
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Visual 5B-XVI: Preview Window: Creatures:

By clicking on the Preview button  in the Preview toolbar above the Main
Display, a new window opens that will display general details about that creature.  The
details include the Name, Tag, Blueprint ResRef, Comments, Faction, and Challenge
Rating; however, they cannot be changed from this window.

Quick Summary and Review:
• Every monster or NPC is categorized and alphabetized in both the “Standard” and

“Custom” Palettes.
• Each creature can be customized through editing the Properties window menu.
• In the Properties window, the Faction Editor can also be accessed and edited.
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CCCChhhhaaaapppptttteeeerrrr    6666::::

PPPPllllaaaacccceeeeaaaabbbblllleeee    OOOObbbbjjjjeeeeccccttttssss

Section A: Selecting and Placing

Visual 6A-I: Standard Palette: Placeable Objects:
• You can select an object from any

number of placeable sub-categories
in either the “Standard” or
“Custom” Palettes.  By clicking on
the group, the list will expand to
show every object available under
that group.

•  By right clicking, you can open a
small search window that will find
the text you enter.  This search will
include all “Standard” Palette
categories and types of objects.

•  As with the terrain placement,
when you select an object the
mouse icon will become a
transparent image of the object you
selected.  It will not be placed into
the module until you click a desired
location.

• Depending on the location chosen, the object might fall or rise to an acceptable or
valid location.  This can be manually changed by editing the placeable’s location
on the Z axis, which will be covered later this chapter in Section B.

• Section A-1: Doors:

Visual 6A-II: Standard Palette: Doors:
NWN doors are constructed out of wood,
stone, or metal.  The differences between
them are subtle because of being able to
edit the properties to whatever is desired.
If certain options are selected, each type of
door leaves a different craftable material
after destroyed, except for stone doors.
For most online Mods, this does not apply
because they do not use “trade skill”
systems.
In each category of door, there are several
variations or level of visual quality you
can choose from.
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A door requires a doorway in order to be placed into the area.  When a door is
selected from the Palette, the transparent image of the door will begin to spin in place.
This means that the toolset does not yet detect any place for the door to fit.  Clicking
anyway will simply abort the placement.  Once a valid doorway has been found, the door
will stop spinning and also appear in the doorway that is within a close range.  The
accepted range that a doorway will recognize your selected door appears to be within a
radius of about twenty in-game feet from the doorway.  With the transparent door not
spinning, click to place the door in the doorway.  The blue arrow at the bottom of the
door is the direction the door will swing when opened.  If you desire the door to swing in
another direction, delete the door and place the door in the same way but on the opposite
side.

Right clicking on a door will offer seven options from a pop-up menu.
•  The “Add to Palette” option will copy the same door in a new slot you can

specify.
• The “Conversation” and “Setup Store” options do not apply to doors.
• “Initial State” can set the condition of the door when the area is loaded
• “Delete” deletes the door.
• “Variables” opens the separate Variables window that is related to scripting
• “Properties” will open another window with tabs for the various options

Visual 6A-III: Door Properties: Basic Tab:

The “Basic” tab allows you to change the Name, Tag, Appearance, and statistical
aspects of the door.  The “Hardness” of the door is the number of physical damage it will
absorb before any actual damage is applied to the “Hit Points” value.  The other three
fields are for defensive rolls against certain spells.
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Visual 6A-IV: Door Properties: Lock Tab:

The “Lock” tab has basic check boxes for locking options.  This tab also allows
you to identify the key needed to unlock the door by it’s tag.  You can also set
“Open/Close Lock DC” values to try and thwart the player(s).

• The “Comments” tab leaves a page open for you to write any special comments or
notes about the particular door.

• The “Description” tab allows you to modify what the player(s) will see when they
examine the door.

• The “Scripts” tab displays several circumstances for you to enter scripts upon the
events in-game.  You can also save the script set up to file, or load others from a
folder.

Visual 6A-V: Door Properties: Trap Tab:
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Traps can be a very fun part of doors.  The “Trap Settings” group allows you to
customize every aspect of your trap.  In the “Trap Type” drop-down menu, for every
elemental type of damage there are various levels of trap strength, as well.  The three
fields at the bottom of this window cannot be manually edited, but they will change with
each new trap type entered.  There are also additional slots for scripts in this tab.
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Visual 6A-VI: Door Properties: Advanced Tab:

The “Advanced” tab lets you change the faction to which the door belongs.  This
is important for the relationship with the player and other factions in the game.  When the
PC attacks an object or creature of one faction, the rest of that faction considers the PC to
be hostile towards it, and will react in kind.  You can also change the “Initial State” of the
door, and apply variables.  The ResRef is also displayed at the top of this tab.

The “Area Transition” tab has several features that can add to a unique area, see
Visual 6A-VII below.  This is used for doors that lead to other areas in a module.  If you
know the Destination Tag, you can enter it in the first field; otherwise, click the “Setup
Area Transition” button on the bottom of the screen to launch the “Area Transition”
selection window.

In the “Area Transition” window, as seen in Visual 6A-IX below, you have four
groups of options to help you find a destination for the door.  First, you can select a
specific area in the module from a drop-down menu.  On the right hand side of the
window, you are able to navigate a basic representation of the chosen area by holding
down the right or left mouse button and moving the mouse.  The “Target Type” identifies
what the PC will travel to.  Triggers and Doors allow for all three possible “Connection
Types” to be available, but destinations that lead to waypoints have no means to return
the same way because waypoints are intangible and invisible objects in-game.  Changing
the “Connection Type” will also refresh the list of “Available Doors” with every valid
destination.  Once you click the “OK” box, the toolset requires you to save the changes to
the module.  If the target destination is a standard and unchanged door, the toolset will
make sure you wish to use it.  If there are more than one paths between a pair of doors,
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the toolset will warn you and ask for clarification if you would like to overwrite the
previous connection or cancel the new one.

 The other feature of the transition is the option to assign different loading screens
in between separate areas.  See Visual 6A-VIII below.  The default setting is a random
choice from the respective tileset.  Once the “Use default loading screen for Area” has
been unchecked, you are able to select from several different versions from any tileset in
the game with the “Filters” option group drop-down menu.

Visual 6A-VII: Door Properties: Area Transition Tab:
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Visual 6A-VIII: Door Properties: Loading Screen:

Visual 6A-IX: Door Properties: Area Transition Tab: Destination Options:
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Section A-2: Encounters:  Unfortunately, this is one area I have no experience in.  Both
Mods I have worked for have delegated the creature and encounter tasks to other
builders, while the area builders could concentrate on the areas alone.  However, for a
tutorial in encounter construction, see the “Encounter Wizard” section of the NWN
Aurora Toolset Help Guide, just after the Creature Wizard that is almost half way down
the “Wizards” topic.  For the page to download the Aurora Guide from the NWN Vault,
visit: http://nwvault.ign.com/Files/other/data/1038020754190.shtml
You can also download an 11 meg zipped step-by-step movie at:
http://nwvault.ign.com/Files/movies/data/1028578623460.shtml

• Section A-3: Items and Equipment Placeables:
The items have another Wizard to create custom equipment, if desired.  The

“Standard” Palette lists every item used in the single player campaign, and categorizes
equipment into armor and weapon types, as well as several others including
miscellaneous and plot items.  Any of these items can be selected and dropped into the
module.  In order to set the item as a buyable product from a merchant, see the next
section.

If you desire to make a new item, right click anywhere on the “Custom” Palette
list and select “New” from the pop-up menu.

•  The Item Wizard will start by asking you to choose what kind of item, out of
several dozen, you wish to create.  Depending on what category you choose, the
available properties, portraits, and designs will change slightly.

• The next step of the wizard is to ask you for a name.  Like areas, creatures, and
doors, it is best to interpret this as the request for the object’s resref.  You can also
choose to make this item “magical” by checking the box.  The bottom half of this
window will illuminate and allow you to choose the item’s require level for use
and the strength of the magical enchantments.  The strength of enchantments sets
a requirement for magical effects in the properties options when the item is edited.

• The last step before finishing will allow you to choose which Palette list the item
will appear in.  Before finishing, the Wizard gives you the opportunity to launch
the Item Properties window as a box option in the bottom corner of the screen.

http://nwvault.ign.com/Files/other/data/1038020754190.shtml
http://nwvault.ign.com/Files/movies/data/1028578623460.shtml
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Visual 6A-X: Item Properties Window: General Tab:

The “General” tab of the Item Properties window displays basic information
about a selected item.  Here, you can set additional magic charges; increase or decrease
the item cost, and mark the item as “Stolen” or as a “Plot Item”.  You can change the
name and the tag here as well, but again, the resref cannot be altered outside the creation
Wizard.  See Visual 6A-X above.

You can set various top, middle, and bottom portions of the weapon to different
colors and styles in the “Appearance” tab with the drop-down menus.

The “Properties” tab has two columns you can edit, “Available Properties” and
“Assigned Properties”, and a button in the bottom right corner for additional options
labeled “Edit Property”.  You can also assign this weapon “Undroppable” and
“Identified” properties.  The assignment column for properties lists all available magical
enchantments for the item, although some properties only apply to certain types of items.
To assign a property to the item, double-click the effect.  In the “Visual Effect”
properties, the effect displayed on the weapon takes alphabetic priority, which means that
if Acid and Sonic were applied, only the Acid property would be visible.  The visual
effects do not stack.  See Visual 6A-XI below.

For each of the many types of items, different properties, conditions, and uses
apply.  However, they all still have the same tabs in the “Item Properties” window,
though they may have a different setup.



April, 2004 NWN Toolset Chapter 6: Placeable Objects

Version 1 NWN: SoU, HotU 58

Visual 6A-XI: Item Properties: Properties Tab:

The “Description” tab allows you to enter what the player will see in-game for
both when the item is unidentified as well as when it is identified.  This window also
gives you a summary and description of the type of weapon.  A summary of the applied
effects is below the Unidentified and Identified columns.

The “Comments” tab is another blank window to enter any comments you desire.
The “Appearance” tab allows you to fully customize the look of your item.  Using

the drop-down menus for every category of appearance of the item you can scroll through
the large number of available sets.  Armor is the most customizable item in the toolset.
See Visual 7A-XII below.  You can select between male and female templates to model
the armor.  Along with changing the shape and type of your armor, you can also adjust
the color to the three types of material.  This option can be accessed by clicking on the
“Color” button in the top right of the window.  For each material, you can select between
two more categorizations.  See Visual 7A-XIII below.
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Visual 6A-XII: Item Properties: Appearance:

Visual 6A-XIII: Item Properties: Appearance: Color:
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• Section A-4: Merchants:

Merchants are easily stated by right-clicking on any creature, and selecting “Setup
Sore” from the pop-up menu. When the Store Setup Wizard launches, it will start with
the opening conversation of the merchant.  See Visual 6A-XII below.

• You can set the question of the merchant, and the acceptance or refusal choices of
the PC for the in-game dialogue window.  By checking the “Use Appraise
Checks” box, the merchant will respond to the players Appraise skill and adjust
prices accordingly.  If you want to use other scripts for the opening of the store or
the conversation, you can specify those in the two fields at the bottom of the
window.

•  Next, you can choose what kind of store this merchant will be, or rather, what
goods he/she/it will sell.  Creating a custom store requires you to switch to the
“Custom” Palette and right click on any listed option, selecting “New” from the
pop-up menu.  This will launch the Merchant Wizard.  Otherwise, the Store Setup
Wizard will finish upon selection of a store type.

• In the Merchant Wizard, the first window asks you to assign a location for the file
in the Palette.

•  Next, you can enter a name and then check the “Launch Properties Dialog”
window after the Merchant Wizard closes.

Once the Wizard(s) have closed, you may notice a yellow arrow with a blue flag
sitting at the under the creature, a waypoint.  This is the actual store that applies to that
creature.  To edit the properties or wares of the store, right click on the waypoint and
select “Properties” from the pop-up menu.

The properties window is divided into four tabs, “Basic,” “Advanced,”
“Restrictions,” and “Comments.”

• The “Basic” tab allows you to adjust price rates, amount of gold the store has,
restrictions for stolen goods, and cap the maximum buying price.  See Visual 6A-
XIV below.  The “Inventory” button in the bottom left will open an inventory list
so you can pick and choose which particular items are available.

•  The “Advanced Tab” displays the resref and allows you to use scripts on the
“OnOpenStore” and “OnStoreClose” circumstances.

•  The “Restrictions” tab specifies particular items the merchant will only buy or
will not buy from the player.
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Visual 6A-XIV: Store Setup Wizard: Conversation Options:

Visual 6A-XV: Merchant Properties: Basic Tab:
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Note: Chapter 6 continues in the next document: Chapter 6 Part 2.

Quick Summary and Review:
• There are two types of objects: pre-made and custom.
• Placeables are classified under race (for creatures) or type (for objects) in

alphabetical lists in the Palette.
• Every Placeable has a separate Properties window that allows for customization.
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CCCChhhhaaaapppptttteeeerrrr    6666

CCCCoooonnnnttttiiiinnnnuuuueeeedddd::::

• Section A-5: Placeable Sounds:

Visual 6A-XVI: Standard Palette: Placeable Sounds:

There are several categories of sounds, and you can create your own group of
sounds from well over ten thousand different .wav files archived into separate groups.  To
place a sound, highlight one from any group and place it in the module.  Once again, your
mouse icon becomes the object you highlight.  Drop it where desired.

There are three different types of sound files.  All three representations of the
sound file in the area have a black note hovering over another object.  That object will tell
you its positioning.  The red ring indicates a sound file that plays everywhere in the area.
The white dice on edge means that the sound will play from random locations in the area.
The red arrow pointing down will play the sounds from that specific spot.  See Visual
6A- below.

Visual 6A-XVII: Placeable Sound Appearance Types:
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In the properties window of a sound file, There are three tabs to help customize
the file.

• The “Basic” tab simply lists the sounds, and allows you to adjust the name, tag,
add comments, play the individual sounds, and even adjust the volume.  See
Visual 6A-XVII below.

• The “Positioning” tab adjusts the specific location and range of the sound.  See
Visual 6A-XVIII below.

• The “Advanced” tab can adjust several aspects of when and how the sound will
play, including specific hours of the day or night, playing once or repeating,
intervals, and variations in pitch and volume for each interval.  See Visual 6A-
XIX below.

Visual 6A-XVIII: Sound Properties: Basic Tab:

• The volume can be adjusted by click and dragging the bar from 0 to 10, where 10
is the loudest, at the bottom of the window.

• To play individual sounds, highlight a chosen file and click on the “Play” button.
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Visual 6A-XIX: Sound Properties: Positioning Tab:

The range of the sound file can be altered from the “Positioning” tab.
• The first group of options ask for either playing everywhere in the area, playing in

random locations in the area, or from a specific spot.
•  Depending on which is selected, you can change the “Cutoff distance,” or the

distance from where the PC can hear the sounds, as well as from which height.
• If you chose the sound to be random, you can contain the random range.
• These distances are in in-game meters.

Visual 6A-XX: Sound Properties: Advanced Tab:
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The “Advanced” tab allows for precise timing for when the sound is played.
• You can also choose to have the sound play once, repeating, or even seamlessly

looping, for certain files.
• If there are more than one sound files attached to the group, they can be set for

random or sequential order.
• You can also adjust the interval between each time the sound is played, as well as

set a variation in seconds.
•  For each iteration of the looping sounds, you can adjust volume and pitch

variations (in octaves) by sliding the appropriate bars at the bottom of the
window.

• Section A-6: Triggers:

The Triggers placeables are grouped into Area Transitions, Generic Triggers, Secret
Objects, and Traps.  A trigger is an area that will fire off scripts or effects when the PC
walks in to or out of that area.  There are no objects that represent the triggers category
for placeables.  Instead, the mouse icon becomes a white brush object.  By outlining an
area, double-clicking when finished, the area seals itself and becomes tangible.

Area Transitions are seen in the toolset as blue outlines of an area.  In-game, they are
seen as a sheet of blue when the player’s mouse moves over the area.  These triggers will
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move the PC from one location to another, much like doors.  The Properties window is
divided into five tabs, including the “Basic,” “Area Transition,” “Scripts,” “Advanced,”
and “Comments” tabs.

•  The “Basic” tab displays the name and tag, allowing you to select the type of
trigger from a drop-down menu.

• The “Area Transition” is a duplication of the Doors Property “Area Transition”
tab, with the most of the same limitations and guidelines as for doors.  See Visual
6A-IX, and the “Door Properties” details of Section A-1.  A major difference with
the transition triggers appears when the trigger is the destination for a transition.
In this case, the destination becomes a waypoint.  The waypoint can be rotated in
different directions, allowing the PC to face that direction when they appear in the
area.  Waypoints will be explained in more detail in the next Section.

• The “Scripts” tab allows you to enter various scripts for different situations, such
as entering or leaving the trigger.  You can also load or save script sets to file.

• In the “Advanced” tab, can adjust the “Highlight Height”.  Though the option for
changing the cursor is visible, it cannot be changed here.  You can, however,
change the portrait of the trigger.  There is a “Variables” button at the bottom of
the screen, which will open another window so you can add or remove any
desired variables for scripts.

The “Generic Trigger” runs various scripts, including those for henchmen.

The “Secret Objects Trigger” can be used with a PC’s henchmen, and allow for detection
checks for various treasures or objects.

The “Traps” triggers will set up a trap of the desired magnitude and element for the PC to
walk in.  The “Traps” tab in the Properties window for traps is a duplication of the door
traps tab, which can be seen with Visual 6A-V.

• Section A-7: Waypoints:

The most commonly used waypoints are “Waypoints” and “Map Notes”.  Waypoints
have several uses and are fast to create and edit.  Map Notes will appear on the PC’s
mini-map in-game as a dull gold point with a text reference.  The color of the flag and the
shape of the object can be changed in the “Basic” tab of the “Waypoint Properties”
window.

One use for waypoints is with creatures.  With a creature highlighted in the area,
move the mouse well away from the creature and right click.  A single option will appear
in the pop-up menu: “Create Waypoint”.  This will set a point for the creature to walk to.
You can set as many as the situation requires, and the creature will walk down the path,
then reverse course and walk back the other way when the end is reached.

Another use is for a destination from a door or area transition.
The only difference between a “Waypoint” and a “Map Note” is that a map note is

defaulted to the “Waypoint Contains a Map Note” box set to active.  The text that will
appear in-game should be entered in the “Map Note Text” field.  See Visual 6A-XX
below.
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Visual 6A-XXI: Waypoint Properties: Map Note Difference:
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Section B: Placeable Object Properties Window

When you have created a custom object, it will appear in the “Custom” Palette
list.  Editing a “Custom” or “Standard” Palette object can be done by right clicking on the
object and selecting “Edit” from the pop-up menu.  Selecting “Edit Copy” will open the
Properties window and place an edited duplicate of the object in the “Custom” Palette
lists under the category of the original.  Using “Edit Copy” will allow you to change the
resref, which has also been altered.  The default alteration to the resref of a copy is to add
three numbers on the end.  These numbers will appear sequential if multiple copies are
made.  If the original object did not have at least three numbers at the end of the resref, it
will be changed to “…001”.  Though the default sets three numbers, the toolset will
adjust to increment the number assigned to other copies beyond three digits.

As with most objects and creatures, the “Placeable Object Properties” window
that loads when you edit an object is divided into tabs.  In the “Basic” tab, if you check
the “Usable” box the “Lock” and “Trap” tabs will also become available.  Even if an
object is useable, it is not required to add lock or trap properties.

Visual 6B-I: Object Properties: Basic Tab:

• The “Basic Tab” displays the Name, Tag, and Appearance Type for the object.
You can also assign the “Plot,” “Usable,” and “Static” check boxes.  See Visual
6B-I above.

o The “Plot” box is used to mark the object as completely indestructible and
immune to all damage types.
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o  The “Usable” box will allow the player to examine, attack, and use the
object.  Without this box checked, the object will remain as part of the
intangible background geometry of the game.

o  The “Static” attribute is similar to the “Plot” feature, but will not allow
visual effects and the like to affect it.  Note: if you are adding visual
effects to objects, for example Shadow Shield, any “Static” object will not
be affected, but “Plot” objects will.

o The maximum “Hardness” value is 250.
o The maximum “Hit Points” value is 10,000.
o Each save throw slot can go to 250.

•  One interesting note is that the “Appearance Type” lists every available object
appearance in the game.  However, there are at least two appearances that are not
available in the “Standard” Palette.  These items are the “Mystic Forge” and the
“Mythallar”.

•  The “Scripts Tab” option allows you to place a number of scripts into several
conditions, as well as load or save a script set to file.

• “Advanced Tab” allows you to change which faction owns the object.  You can
also change the portrait and “Initial State” from this tab.

• The “Description” tab allows you to change the in-game description of the object
when a player examines it.

• The “Comments” tab is a blank window where you can add any additional notes.

Quick Summary and Review:
• There are three types of sound placeables in terms of playing location: looping,

random, and fixed.
• You can adjust location and even playing hour from the Properties window.
• Waypoints are used for targeting specific locations, scripts, map notes, and

waypoints for NPC or Monster patrol routs.
• Triggers can be used for area transitions, traps, and executing scripts.
• Placeable objects can be toggled between their level of interaction with the PC in-

game
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CCCChhhhaaaapppptttteeeerrrr    7777::::

MMMMoooodddduuuulllleeee    aaaannnndddd    AAAArrrreeeeaaaa    PPPPrrrrooooppppeeeerrrrttttiiiieeeessss

This chapter will explore the properties for the entire module and the areas within
that module.  The properties of the module and area are displayed for you in separate
windows that use the tab style menu system.

Section A: Setting Module Properties
You can access the Module Properties through the Edit menu bar and selecting

“Module Properties.”  A separate window will open, displaying the properties on six
different tabs.

Visual 7A-I: Module Properties: Basic Tab:

• The “Basic” tab displays the
Name and Tag for the area.  You
can also see which area the player
will start in at the “Start Area”
field.  Coordinates along the X, Y,
and Z, axis are given to pinpoint
the starting location for the player.

• The “Custom Content” tab is used
to display information about Hak
Packs being used.  For more
information on Hak Packs, visit
http://nwvault.ign.com/Files/movi
es/data/1038173402360.shtml

• You can visit this link for an
example of what Hak Packs can be
used for:
http://downloads.gameplanet.co.nz
/dl.dyn/Files/3210.html

• The “Events” tab lists a large
number of situations and
circumstances you can add custom
scripts to.

Visual 7A-II: Module Properties: Advanced Tab:

http://nwvault.ign.com/Files/movies/data/1038173402360.shtml
http://downloads.gameplanet.co.nz/dl.dyn/Files/3210.html
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The “Advanced” tab allows you to set
detailed values on several aspects of the
module, including dawn and dusk time,
and the starting time, hours to years, for
your module.  You can also adjust the
experience scale, and choose a starting
movie from the drop-down menu
(possibly your own?).

Visual 7A-III: Module Properties: Cached Scripts Tab:

The “Cashed Scripts” tab allows you to
build a list scripts that are frequently used
in your module.  For more information
about Bioware’s cached scripts, visit
http://nwn.bioware.com/developers/Biow
are_Aurora_IFO_Format.pdf

http://nwn.bioware.com/developers/Biow
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Section B: Area Properties:
Editing the “Area Properties” window for each individual area is a good way to

add a unique feel to your module.  The window can be accessed from the “Area
Properties“ option in the Edit menu bar.  Note that the properties set will only affect the
current area selected.

Visual 7B-I: Area Properties: Visual Tab:

• The “Basic” tab
displays the area
Name, tile set, and
dimensions.  Only the
name can be changed.

• The “Visual” tab lists
all available types of
weather and lighting
for the area.  You can
also create a custom
environment by
clicking on the
“Customize
Environment” button
at the bottom of the
window.  See Visual
7B-II below.
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Visual 7B-II: Area Properties: Environment Options:

Each field of the
“Environment” window affects
a certain aspect of your
customized weather.  Clicking
on any colored box will open
the color wheel for assignment
of custom colors.  The “Sky
Box” field is used to set the
type of sky seen in-game.
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Visual 7B-III: Area Properties: Audio Tab:

The “Audio” tab
assigns Ambient,
Environmental Effects,
background music, and
combat music.  These
can also be changed to
have separate music for
night and day.  You can
also set the delay in
between the music
tracks in the “Music,
Playing Delay” field,
which is measured in
real-time seconds.

• The “Events” tab allows you to set custom scripts into different circumstances and
situations for the specific area.
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Visual 7B-IV: Area Properties: Advanced Tab:

The “Advanced” tab displays the details about the area.
• Here, you can set two different “Check Modifier” for anyone using the Listen or

Spot skills.
• You can also change the screen seen while the area loads by clicking on the “…”

box at the end of the “Loading Screen” field.
• The Tag is displayed here, which can be changed.  The ResRef is displayed here

as well, but it cannot be changed at this point.
• You can also adjust the type of terrain.

Quick Summary and Review:
• The Module and Area Properties windows can be accessed from the Edit menu

bar.
• Each of the Properties windows has multiple tabs used to customize the different

aspects of your module.
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RRRRaaaannnnddddoooommmm    BBBBuuuuiiiillllddddiiiinnnngggg    HHHHiiiinnnnttttssss    aaaannnndddd    TTTTiiiippppssss

• A Good Resource for Builders:
http://nwn.bioware.com/builders

• Secret Appearances:
In the properties section of objects, under the “Appearance Type” drop down

menu, there are certain appearances that are not available in the standard palette!  One of
which is the “Mystic Forge” and “Mythallar”.  These are two of the coolest looking
placeables yet.  The forge is the Drow forge seen in HotU Resistance Camp, and later in a
place that may be considered a spoiler if mentioned!  There are no special properties for
the Forge, but I have noticed that there is a strange querk with the “Mythallar” that I have
not been able to reproduce lately.  When I first found them, the pulsing and glowing was
not activated when placed, but began after I checked off “Static”.

For creatures, one that I have found is the “Mephistopheles” and “Meph.. Large”.
The first one is a small humanoid sized demon of the main villain in HotU, the second
one is his larger form with wings.

• Scripting and Objects: Settings of the Object:
When scripting effects, such as Shadow Shield, onto objects, remember to un-check

the “Static” box, or the script will not be able to target the object.

Blocking PC movement with fallen timber set to destroyed

• DM Character vs Player Character for Area Testing:
When testing out an area, especially large areas, create a simple amulet with one

effect when worn: haste and place it next to the start location.  It is recommended to use
player characters to test out your area rather than a DM character.  Yes, DM chars are
faster and have fun properties, but they do not set off triggers and certain scripts.  Just
remember to delete the amulet before submission =)

• Hak Packs:
A hak pack is something you can download from the net or even NWN Vault that

can improve your Mod or just make it a little more fun.  There is a great deal of material
for these hak packs, but one I recommend is for portrait and voice set improvements.
Depending on which is used, they can allow the player to select any portrait and any
voice set available in the game, not just the standard ones.  It’s fun to use voice sets for
demons or even the end boss for your player.

• Changing Dozens or Hundreds of Objects at Once:
If you want to add something to multiple copies of one object (resref blueprint

copies) edit the object in the Custom Palette list (not the placed object).  Then, right click
on the object in the Custom Palette to open the options pop-up menu, and select “Update
Instances.”  Now every copy will be edited to match the template you just finished.  This
will overwrite any previous changes, though.  This is a great feature for situations like
adding a book to a bookshelf placeable in a library.

http://nwn.bioware.com/builders
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SSSSccccrrrriiiippppttttiiiinnnngggg    EEEExxxxaaaammmmpppplllleeeessss::::

Once again, I would like to point out that almost all of the scripts I have
constructed were edited and placed from Lilac Soul’s Script Generator!  This program is
a work of art, and can help anyone get started using scripts.  The interface for the
generator is very simple and very user friendly.  No prior scripting skills are needed,
though being able to recognize certain aspects of code will help.  I believe anyone can
use the generator to turn out scripts for their Mods.  And for a quick quote from Lilac
Soul’s web page (link listed below), “February 11th: 45,000 downloads reached!”.
I intend for these scripts to be examples to help others.  Feel free to copy and do what ya
like with them-that’s the best way to learn!

• For the most impressive script resource I have found: Recommended!!!
http://lilacsoul.revility.com/

• For various scripts from the Neverwinter Nights Vault:
http://nwvault.ign.com/Files/scripts/categories/Inventory%20ItemType%20-
%20Unique%20Items2.shtml

• For extensive details and the best resource for understanding the script:
http://www.nwnlexicon.com/

• Another great link for scripting resources and examples:
http://www.lemonbutter.com/

• Another good link page:
http://www.sorcerers.net/Games/NWN/index_toolset3_4.htm

• This link also has other references for scripting:
http://nwvault.ign.com/modules/wydraz/tutorial/

http://lilacsoul.revility.com/
http://nwvault.ign.com/Files/scripts/categories/Inventory%20ItemType%20-
http://www.nwnlexicon.com/
http://www.lemonbutter.com/
http://www.sorcerers.net/Games/NWN/index_toolset3_4.htm
http://nwvault.ign.com/modules/wydraz/tutorial/


April, 2004 NWN Toolset Scripting Examples

Version 1 NWN: SoU, HotU 79

Scripts I have used in modules
(with much help from Lilac Soul’s awesome Script Generator):

• Script I: The Best Healing Spell
My clan healer uses this spell.  Simple enough.

Setup: Place a healer creature.  Place four braziers for visual effects.  Place a
waypoint in front of the healer where the PC will be when talking to the healer.
Create a Summoning Circle object, found in the Visual Effects category of the
Placeables palette.

Tags:
Healer: UD_OHQPriest01
Braziers(4): UD_OHQPriestsFlamingBrazier1 - UD_OHQPriestsFlamingBrazier4
Waypoint: UD_OHQHealingVisEffect
Summoning Circle: UD_OHQSumCircle02

• Summoning Circle ResRef: ud_ohqsumcircle1

Place this script in the “Text Appears When” tab in the Conversation Editor for
the healer.  The line should be the healer’s agreement to heal the PC (last line of

that branch of the conversation tree)
/*   Script generated by
Lilac Soul's NWN Script Generator, v. 1.6

For download info, please visit:
http://www.lilacsoul.revility.com    */

void main()
{
object oTarget;
object oSpawn;
location lTarget;
int nInt;
object oPC = GetPCSpeaker();
object oCaster;

oCaster = OBJECT_SELF;
oTarget = oPC;

//cast the spells
DelayCommand(1.0,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_MORDENKAINENS_DISJUNCTION, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE)));

http://www.lilacsoul.revility.com
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DelayCommand(1.2,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_MORDENKAINENS_DISJUNCTION, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE)));
DelayCommand(1.4,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_GREATER_RESTORATION, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE)));
DelayCommand(1.6,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_REMOVE_CURSE, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE)));
DelayCommand(1.8,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_REMOVE_DISEASE, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE)));
DelayCommand(2.0,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_REMOVE_BLINDNESS_AND_DEAFNESS,
oTarget, METAMAGIC_ANY, TRUE, 40,
PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));
DelayCommand(2.2,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_NEUTRALIZE_POISON, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE)));
DelayCommand(2.8,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_HEAL, oTarget, METAMAGIC_ANY, TRUE, 40,
PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));

//summoning circle visual
oTarget = GetWaypointByTag("UD_OHQHealingVisEffect");
lTarget = GetLocation(oTarget);
oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "ud_ohqsumcircle1",
lTarget);
oTarget=GetObjectByTag("UD_OHQSumCircle01");
DestroyObject(oTarget,3.5f);

//flame visual on all four braziers
oTarget = GetObjectByTag("UD_OHQPriestsFlamingBrazier1");
nInt = GetObjectType(oTarget);
if (nInt != OBJECT_TYPE_WAYPOINT)
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), oTarget);
else ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), GetLocation(oTarget));

oTarget = GetObjectByTag("UD_OHQPriestsFlamingBrazier2");
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nInt = GetObjectType(oTarget);
if (nInt != OBJECT_TYPE_WAYPOINT)
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), oTarget);
else ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), GetLocation(oTarget));

oTarget = GetObjectByTag("UD_OHQPriestsFlamingBrazier3");
nInt = GetObjectType(oTarget);
if (nInt != OBJECT_TYPE_WAYPOINT)
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), oTarget);
else ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), GetLocation(oTarget));

oTarget = GetObjectByTag("UD_OHQPriestsFlamingBrazier4");
nInt = GetObjectType(oTarget);
if (nInt != OBJECT_TYPE_WAYPOINT)
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), oTarget);
else ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DIVINE_STRIKE_FIRE), GetLocation(oTarget));
}
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• Script II: Setting the Mood with Ominous Looking Objects:
This script will put a nice and dark feel to any object.  Specifically, this script was used in
an evil head quarters for a clan.  I didn’t want the chairs to be normal wooden things, so I
looked for alternate appearances.  The actual script used is below the screen shot.

Visual I-I for Scripting Examples: Object Shadow Shield: Sitting in the Meeting Hall:

void main()
{
object oPC = GetEnteringObject();
if (!GetIsPC(oPC)) return;
object oCaster;
object oTarget;
oTarget = GetObjectByTag("UD_OHQSitableChair01");
oCaster = oTarget;
oTarget = GetObjectByTag("UD_OHQSitableChair01");
AssignCommand(oCaster, ActionCastSpellAtObject(SPELL_SHADOW_SHIELD,
oTarget, METAMAGIC_ANY, TRUE, 50, PROJECTILE_PATH_TYPE_DEFAULT,
TRUE));
…
}//end main
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For each object you would want the effect to be applied to, add the last two “oTarget”
and “AssignCommand” lines and replace the oTarget target tag with the intended object
for each other object.  Additional targets were written in place of the “…” of the script.
In my example, there were about forty other pairs of separate declarations: one for each
chair and throne in the Meeting Hall, and various other things.

• Script III: Closing Door Script:
This was again used in my clan hall area to close a door after a few seconds:
void main()
{
object oPC = GetLastUsedBy();
if (!GetIsPC(oPC)) return;
object oTarget;
oTarget = OBJECT_SELF;
DelayCommand(3.5, AssignCommand(oTarget, ActionCloseDoor(oTarget)));
}

• Script IV: A more complex script: Trap for Unwelcome Guests:
This script took a good while to perfect, but it works beautifully!!   It was designed to
damage/attack intruders in the clan hall, reliant upon an object what would prevent the
script from firing.  What happens: after you enter a door, a floor area triggers that casts a
pair of fireballs from two ballista pointed right at you, the fireball is for show, the damage
is coded.  Leaving the trigger will summon two castings of Greater Ruin.  The trigger has
a wacky design to it, making it hard for anyone to avoid much damage..  Then, two near-
by sphinx statues explode, spawning a pair of enchanted and quite powerful manticores.
The creatures are hostile, but will be despawned after a time to allow the members to
walk around in the area.  When the manticores die (despawn or death) another statue
appears where it was before, ready to be triggered yet again.  It will despawn after 120
seconds, that can be modified in the last line or so of the OnSpawn script for the creature.

Setup: Draw an area trigger in a room.  Place 2 statues.  Place 2 waypoints under the
statues, and have the arrow pointed in the opposite direction for respawning of the statues
in the same direction (bioware bug?).  Create two beasts in the creature custom palette,
but do not place them in the area.  You don’t want the rabid guardians defaulted to spawn
somewhere, in this situation.  Create an object for the trigger identify FoF(friend or foe)
for the clan, there by triggering counter measures or not.

Tags:
Trigger: UD_OHQFireingRange1
Statue 1: UD_OHQ_SphinxGuard01
Statue 2: UD_OHQ_SphinxGuard02
Manticore 1: UD_OHQStatGuard001TAG
Manticore 2: UD_OHQStatGuard002TAG
Safeguard Object: UD_OHQOblivianFragmentTAG
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Here is the full scripting with what goes where (three different script location types):

On the trigger, OnEnter:
/*   Script help from
Lilac Soul's NWN Script Generator, v. 1.6

For download info, please visit:
http://www.lilacsoul.revility.com    */

/*********************************************************************
The purpose of this script is to kill intruders who dont have the
Oblivian Fragment. This is, after all, a headquarters for a clan.
**********************************************************************/
#include "nw_i0_generic"
void main()
{
object oCaster;
object oTarget;
object oPC = GetEnteringObject();
effect eEffect;
int nInt;

if (!GetIsPC(oPC)) return;

if (GetItemPossessedBy(oPC, "UD_OHQOblivianFragmentTAG")!=
OBJECT_INVALID)
   return;

//free the guardians from their statues
oTarget = GetObjectByTag("UD_OHQ_SphinxGuard01");
eEffect = EffectDamage(100, DAMAGE_TYPE_MAGICAL,
DAMAGE_POWER_NORMAL);
ApplyEffectToObject(DURATION_TYPE_INSTANT, eEffect, oTarget);
oTarget = GetObjectByTag("UD_OHQ_SphinxGuard02");
eEffect = EffectDamage(100, DAMAGE_TYPE_MAGICAL,
DAMAGE_POWER_NORMAL);
ApplyEffectToObject(DURATION_TYPE_INSTANT, eEffect, oTarget);

//make the statue attack the PC who entered
oTarget = GetObjectByTag("UD_OHQStatGuard001TAG");
SetIsTemporaryEnemy(oPC, oTarget);
DelayCommand(0.3,AssignCommand(oTarget, ActionAttack(oPC)));
DelayCommand(0.5,AssignCommand(oTarget, DetermineCombatRound(oPC)));
oTarget = GetObjectByTag("UD_OHQStatGuard002TAG");
SetIsTemporaryEnemy(oPC, oTarget);
DelayCommand(0.3,AssignCommand(oTarget, ActionAttack(oPC)));

http://www.lilacsoul.revility.com
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DelayCommand(0.5,AssignCommand(oTarget, DetermineCombatRound(oPC)));

//ballista 1 fires
oCaster = GetObjectByTag("UD_OHQBallista01");
oTarget = oPC;
AssignCommand(oCaster, ActionCastSpellAtObject(SPELL_FIREBALL, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE));

//ballista 2 fires
oCaster = GetObjectByTag("UD_OHQBallista02");
oTarget = oPC;
AssignCommand(oCaster, ActionCastSpellAtObject(SPELL_FIREBALL, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE));

//add blind and do damage
oTarget = oPC;

eEffect = EffectDamage(10, DAMAGE_TYPE_MAGICAL,
DAMAGE_POWER_NORMAL);
DelayCommand(0.7,ApplyEffectToObject(DURATION_TYPE_INSTANT, eEffect,
oPC));

eEffect = EffectDamage(10, DAMAGE_TYPE_DIVINE,
DAMAGE_POWER_NORMAL);
DelayCommand(0.7,ApplyEffectToObject(DURATION_TYPE_INSTANT, eEffect,
oPC));

//use the destruction visual effect on PC
oTarget = oPC;
nInt = GetObjectType(oTarget);
if (nInt != OBJECT_TYPE_WAYPOINT)
DelayCommand(0.5,ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DESTRUCTION), oTarget));
else DelayCommand(0.7,ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_DESTRUCTION), GetLocation(oTarget)));
}

In the trigger OnExit:
/*   Script generated by
Lilac Soul's NWN Script Generator, v. 1.6

For download info, please visit:
http://www.lilacsoul.revility.com    */

http://www.lilacsoul.revility.com
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void main()
{
object oCaster;
object oTarget;
object oPC = GetExitingObject();

if (!GetIsPC(oPC)) return;

if (GetItemPossessedBy(oPC, "UD_OHQOblivianFragmentTAG")!=
OBJECT_INVALID)
   return;

//ballista 1 fires
oCaster = GetObjectByTag("UD_OHQBallista01");
oTarget = oPC;
AssignCommand(oCaster, ActionCastSpellAtObject(SPELL_EPIC_RUIN, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE));

//ballista 2 fires
oCaster = GetObjectByTag("UD_OHQBallista01");
oTarget = oPC;
DelayCommand(0.5,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_EPIC_RUIN, oTarget, METAMAGIC_ANY, TRUE,
40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));
}

Sphinx statue 1(object): OnDeath:
Sitting under the statue is the “UD_OHQSpawnSphinxWP1” waypoint

#include "nw_i0_generic"
/*   Script generated by
Lilac Soul's NWN Script Generator, v. 1.6

For download info, please visit:
http://www.lilacsoul.revility.com    */

void main()
{
object oSpawn;
object oTarget;
object oCaster;
effect eEffect;
location lTarget;

oTarget = GetWaypointByTag("UD_OHQSpawnSphinxWP1");
lTarget = GetLocation(oTarget);
oSpawn = CreateObject(OBJECT_TYPE_CREATURE, "ud_ohqstatguard0", lTarget);

http://www.lilacsoul.revility.com
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oTarget = oSpawn;
}

On sphinx statue 2(object): OnDeath:
Sitting under the statue is the “UD_OHQSpawnSphinxWP2” waypoint

#include "nw_i0_generic"
/*   Script generated by
Lilac Soul's NWN Script Generator, v. 1.6

For download info, please visit:
http://www.lilacsoul.revility.com    */

void main()
{
object oSpawn;
object oTarget;
object oCaster;
effect eEffect;
location lTarget;

oTarget = GetWaypointByTag("UD_OHQSpawnSphinxWP2");
lTarget = GetLocation(oTarget);
oSpawn = CreateObject(OBJECT_TYPE_CREATURE, "ud_ohqstatgua002", lTarget);
oTarget = oSpawn;
}

On the first Manticore custom creature OnDeath slot:  this creature is not placed
because it will appear when needed by the clan =)  I have it sitting in my Special custom
palette area.
//::///////////////////////////////////////////////
//:: Name x2_def_ondeath
//:: Copyright (c) 2001 Bioware Corp.
//:://////////////////////////////////////////////
/*
    Death script for the sphinx statue guardian for
    the Outsider's clan.  Lilac's script generator
    and NWN default script used.
*/
//:://////////////////////////////////////////////
//:: Created By: Keith Warner
//:: Created On: June 11/03
//:://////////////////////////////////////////////

void main()
{
object oTarget;

http://www.lilacsoul.revility.com
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object oSpawn;
location lTarget;

oTarget = GetWaypointByTag("UD_OHQSpawnSphinxWP1");
lTarget = GetLocation(oTarget);
oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "udohqguard001", lTarget);
oTarget = oSpawn;
}

First Manticore OnSpawn
void main()
{
object oCaster;
object oTarget;
effect eEffect;

//now to give the guardian an edge
oCaster = GetObjectByTag("UD_OHQBallista01");
oTarget = GetObjectByTag("UD_OHQStatGuard001TAG");
AssignCommand(oCaster, ActionCastSpellAtObject(SPELL_PREMONITION, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE));
DelayCommand(0.1,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_GREATER_STONESKIN, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));
DelayCommand(0.2,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_SHADOW_SHIELD, oTarget, METAMAGIC_ANY,
TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));

//safeguard for clan members-the guards will return to statues after time
//oTarget = GetObjectByTag("UD_OHStatGuard001TAG");
//DestroyObject(oTarget, 10.0);
oTarget = GetObjectByTag("UD_OHQStatGuard001TAG");
eEffect = EffectDamage(9990, DAMAGE_TYPE_MAGICAL,
DAMAGE_POWER_NORMAL);
DelayCommand(120.0,ApplyEffectToObject(DURATION_TYPE_INSTANT, eEffect,
oTarget));
}

Second Creature OnDeath:
//::///////////////////////////////////////////////
//:: Name x2_def_ondeath
//:: Copyright (c) 2001 Bioware Corp.
//:://////////////////////////////////////////////
/*
    Death script for the sphinx statue guardian for
    the Outsider's clan.  Lilac's script generator
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    and NWN default script used.
*/
//:://////////////////////////////////////////////
//:: Created By: Keith Warner
//:: Created On: June 11/03
//:://////////////////////////////////////////////

void main()
{
object oTarget;
object oSpawn;
location lTarget;

oTarget = GetWaypointByTag("UD_OHQSpawnSphinxWP2");
lTarget = GetLocation(oTarget);
oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "udohqguard002", lTarget);
oTarget = oSpawn;
//ExecuteScript("nw_c2_default7", OBJECT_SELF);
}

Second Creature OnSpawn:
void main()
{
object oCaster;
object oTarget;
effect eEffect;

//now to give the guardian an edge
oCaster = GetObjectByTag("UD_OHQBallista02");
oTarget = GetObjectByTag("UD_OHQStatGuard002TAG");
AssignCommand(oCaster, ActionCastSpellAtObject(SPELL_PREMONITION, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE));
DelayCommand(0.1,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_GREATER_STONESKIN, oTarget,
METAMAGIC_ANY, TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));
DelayCommand(0.2,AssignCommand(oCaster,
ActionCastSpellAtObject(SPELL_SHADOW_SHIELD, oTarget, METAMAGIC_ANY,
TRUE, 40, PROJECTILE_PATH_TYPE_DEFAULT, TRUE)));

//safeguard for clan members-the guards will return to statues after time
//oTarget = GetObjectByTag("UD_OHStatGuard001TAG");
//DestroyObject(oTarget, 10.0);
oTarget = GetObjectByTag("UD_OHQStatGuard002TAG");
eEffect = EffectDamage(9990, DAMAGE_TYPE_MAGICAL,
DAMAGE_POWER_NORMAL);
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DelayCommand(120.0,ApplyEffectToObject(DURATION_TYPE_INSTANT, eEffect,
oTarget));
}

That’s it =)  Again, most of this was done using the script generator by Lilac Sole.

So, what does it look like in-game?

Visual II-I For Scripting Examples: A Moment To Remember: #1:
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Visual II-II for Scripting Examples: A Moment To Remember: #2:

Visual II-III for Scripting Examples: A Moment To Remember: #3:
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Visual II-IV for Scripting Examples: A Moment To Remember: #4:

Visual II-V for Scripting Examples: A Moment To Remember: #5:
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Script V: Seven Second Visual with a Bless
It is simply that-walk up to the alter-use the object and seven seconds later you get a bless
after a nice light show.

Setup: Place a dragon.  Place an object at the alter you want the PC to use in order to
activate the script (I used a magic spark visual). Create 11 shafts of light, but don’t place
them though, just leave them in the custom palette.  The really annoying part was placing
the waypoints for visual targets-see the visual below.

Visual III-I For Scripting Examples: Dragon Bless Setup:

Tags:
Dragon: dez_mts_BernigGod
Magic spark: dez_mts_alter
Shafts of Light: dez_mts_shaftoflighta

• The shafts are lettered a-k
Shafts of Light ResRef: shaftoflight1

• The resrefs are shaftoflight1, shaftoflight002- shaftoflight011.  The resrefs are
important because of the way the script calls the objects: by resref.  They are
destroyed by tag.

Waypoints:
Lightning targets: dez_mts_callit11- dez_mts_callit32
Shaft of Light targets: dez_mts_viseffectA- dez_mts_viseffectK
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On the usable placeable at the alter(magic spark): OnUsed:
/* With the help of:
    Lilac Soul's NWN Script Generator, v. 1.3
    For download info, please visit:
    http://www.lilacsoul.revility.com
this code is made possible!  This is simply a long visual
effect for the PC when activating the shaft of light at
the Bernig Shrine Interior.  What happens is the dragon
demi-god uses incinerary cloud casting effect(fake spell)
at the same time the PC is dominated instantly. Shafts of
lights form in the room in the shape of a circle from the
god to the PC using waypoints.  They are despawned using
delaycommand in a way that looks like a countdown.  When
the last is gone, there are three layers of lightning bolts
that strike: edge of room, near PC, and on the alter, using
waypoints again.  Then I used the fireball effect when the
bolts are nearest the PC, I think its a cool implosion-
explosion effect. Now the PC is blessed with str, dex, and
con +3, ac +4, attack +5, spell res 15, move reate +10%, and
ultra vision.  This is a once per PC perma bless-lost by
dispel, sleep, and death.  The reasoning behind this is if
a Demi-god blesses you... its goin to stay with you for a
while!  So yeah, here you are, and enjoy!!
*/

void main()
{

//this is the check for one time PC use
object oPC = GetLastUsedBy();

if (!GetIsPC(oPC)) return;

int DoOnce = GetLocalInt(oPC, GetTag(OBJECT_SELF));

if (DoOnce==TRUE) return;

SetLocalInt(oPC, GetTag(OBJECT_SELF), TRUE);

//this starts off with the demigod casting a vis effect to kick off
//the effects sequence
if (!GetIsPC(oPC)) return;

object oCaster;

http://www.lilacsoul.revility.com
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oCaster = GetObjectByTag("dez_mts_BernigGod");

object oTarget;
oTarget = oCaster;

AssignCommand(oCaster,
ActionCastFakeSpellAtObject(SPELL_INVISIBILITY_PURGE, oTarget,
PROJECTILE_PATH_TYPE_DEFAULT));

if (!GetIsPC(oPC)) return;

oTarget = oPC; //redefine oTarget as PC, and not the dragon as above

//this line freezes the PC so they cant leave for the duration of spell
ApplyEffectToObject(DURATION_TYPE_TEMPORARY, EffectDominated(), oTarget,
8.0f);

/*this begins the placement of the shafts of light around the demigod
and player by assigning custom template vis effects via waypoints-
this way they are static and plot on creation.  This is also the
only way I currently know to create them with the option of despawning
them later in the script*/
object oSpawn;
location lTarget;
oTarget = GetWaypointByTag("dez_mts_viseffectA");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight1", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectB");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight002", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectC");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight003", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectD");

lTarget = GetLocation(oTarget);
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oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight004", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectE");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight005", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectF");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight006", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectG");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight007", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectH");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight008", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectI");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight009", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectJ");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight010", lTarget);

oTarget = GetWaypointByTag("dez_mts_viseffectK");

lTarget = GetLocation(oTarget);

oSpawn = CreateObject(OBJECT_TYPE_PLACEABLE, "shaftoflight011", lTarget);
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/*now to destroy the shafts of light in order-this will look
like a countdown-despawned via tag, diff than the resref
used in their creation(took me a while to figure out how to do this
properly)*/
oTarget = GetObjectByTag("dez_mts_shaftoflighta");

DelayCommand(2.3f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightb");

DelayCommand(2.3f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightc");

DelayCommand(2.8f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightd");

DelayCommand(2.8f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflighte");

DelayCommand(3.3f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightf");

DelayCommand(3.3f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightg");

DelayCommand(3.8f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflighth");

DelayCommand(3.8f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflighti");

DelayCommand(4.3f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightj");

DelayCommand(4.3f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_shaftoflightk");
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DelayCommand(5.0f, DestroyObject(oTarget, 0.0));

oTarget = GetObjectByTag("dez_mts_callit11");

/*now begins the lightning rings-this also starts from outer
and ends on the shrine-these are timed just so.  They target
waypoints again*/
int nInt;
nInt = GetObjectType(oTarget);

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.0f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.0f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit12");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.0f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.0f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit13");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.0f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.0f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit14");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.0f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.0f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit15");
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if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.0f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.0f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit16");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.0f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.0f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit21");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit22");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit23");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit24");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));
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oTarget = GetObjectByTag("dez_mts_callit25");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit26");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit27");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.3f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.38f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit31");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.5f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.64f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

oTarget = GetObjectByTag("dez_mts_callit32");

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(6.5f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), oTarget));
else DelayCommand(6.64f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_IMP_LIGHTNING_M), GetLocation(oTarget)));

if (!GetIsPC(oPC)) return;

oTarget = oPC;

/*and now for the actual blessing-these are perma until dispelled,
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death, or rest, but from the condition at the beginning of the script
this can only be done once per PC(reboot/crashes will wipe this clean,
but hey, all the more fun*/
nInt = GetObjectType(oTarget);

if (nInt != OBJECT_TYPE_WAYPOINT) DelayCommand(7.5f,
ApplyEffectToObject(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_FNF_FIREBALL), oTarget));
else DelayCommand(7.5f, ApplyEffectAtLocation(DURATION_TYPE_INSTANT,
EffectVisualEffect(VFX_FNF_FIREBALL), GetLocation(oTarget)));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectAbilityIncrease(ABILITY_CONSTITUTION, 3), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectAbilityIncrease(ABILITY_DEXTERITY, 3), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectAbilityIncrease(ABILITY_STRENGTH, 3), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectACIncrease(4), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectAttackIncrease(5), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectMovementSpeedIncrease(10), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectSpellResistanceIncrease(15), oTarget));

DelayCommand(7.5f, ApplyEffectToObject(DURATION_TYPE_PERMANENT,
EffectUltravision(), oTarget));
}
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Glossary of Terms

• AB: attack base
• AC: armor class
• CR: challenge rating
• Drag and drop method:
• Drop-down menu:  when right clicking, a small grey box will appear next to the

mouse icon
• Grayed-out:  means that the options are not available to be edited
• HotU: Hords of the Underdark
• NWN: Neverwinter Nights
• SoU: Shadows of Undertide
• Tileset:  a particular theme for terrain and geography for an area
• Toolbar:  a display of icons that are shortcuts to different options
• Toolset:  in this case, the toolset is the program used to create the actual game.

Recently, more and more companies have been including their toolsets for their
customers to edit.  This aspect alone convinces many people to buy the game.

• Vis: visual effect
• Wizard:  a program developed to help expedite a process
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SSSSppppeeeecccciiiiaaaallll    TTTThhhhaaaannnnkkkkssss

• NWN Aurora Toolset Help Guide, created by Reginald Silverleaf
This work is recommended reading!
Guide downloadable at:
http://nwvault.ign.com/Files/other/data/1038020754190.shtml

(6.6 meg zipped, 7.25 meg unzipped)

• Sources for alternate guides and instruction from the Bioware Company:
http://nwn.bioware.com/builders/toolsetintro.html

• Bioware’s NWN Vaults: Extreme level of content
http://nwvault.ign.com/index2.shtml

• Lexicon web page covers everything about NWN scripting!
http://www.nwnlexicon.com

• Lexicon also links to a download site for another resource for scripting
http://nwvault.ign.com/Files/other/data/1027899441708.shtml

• Andrew Cantino for taking the time to do movies of tutorials! Encounter movie
at:  (11 meg zip file)
http://nwvault.ign.com/Files/movies/data/1028578623460.shtml

http://nwvault.ign.com/Files/other/data/1038020754190.shtml
http://nwn.bioware.com/builders/toolsetintro.html
http://nwvault.ign.com/index2.shtml
http://www.nwnlexicon.com
http://nwvault.ign.com/Files/other/data/1027899441708.shtml
http://nwvault.ign.com/Files/movies/data/1028578623460.shtml
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\\\\TTTTrrrraaaaddddeeeemmmmaaaarrrrkkkk    aaaannnndddd    LLLLeeeeggggaaaallll    IIIInnnnffffoooorrrrmmmmaaaattttiiiioooonnnn::::

Neverwinter Nights:

NeverWinter Nights, Hordes of the Underdark, Forgotten Realms and the Forgotten
Realms logo, Dungeons & Dragons, D&D, and the Dungeons & Dragons logo, and
Wizards of the Coast and its logo are trademarks of Wizards of the Coast, Inc., in the
U.S.A. and other countries, and are used with permission. © 2003 Wizards. Software ©
2003 Atari Interactive, Inc. All rights reserved. HASBRO and its logo are trademarks of
Hasbro and are used with permission. Windows is either a registered trademark or
trademark of Microsoft Corporation in the United States and/or other countries.
Manufactured and marketed by Atari, Inc., New York, NY. All other trademarks are the
property of their respective owners.

Sources for alternate guides:
http://nwn.bioware.com/builders/toolsetintro.html

Neverwinter Aurora Toolset Guide:
Created by R.S. Barker - NWN Forum name - Reginald Silverleaf.

Bioware:
See http://www.bioware.com/legal/copyright.html for full details.

Lylac Soul’s Script Generator:
See http://lilacsoul.revility.com/ for full details.

Lexicon:

Copyright © 2002-2004 NWN Lexicon Group. Permission is granted to copy, distribute
and/or modify this document under the terms of the GNU Free Documentation License,
Version 1.1 or any later version published by the Free Software Foundation. A copy of
the license is included in the section entitled “License".

Neverwinter Nights © 2004 Infogrames Entertainment, S.A. Some code examples ©
2001-2004 BioWare Corp. BioWare, BioWare Aurora Engine, Shadows of Undrentide,
and Hordes of the Underdark are trademarks of BioWare Corp. Neverwinter Nights,
Forgotten Realms, Dungeons & Dragons, and D&D are trademarks owned by Wizards of
the Coast, Inc., a subsidiary of Hasbro, Inc. All other trademarks are the property of their
respective owners.

Dezmodian’s Toolset Manual:

This is an educational tool and resource.  Other than crediting Dezmodian as the original
writer, all other rights to this work do not apply.  This work is open to the general public
for any use in any way.  You are encouraged to take what you need for any other
projects that may be helpful.

http://nwn.bioware.com/builders/toolsetintro.html
http://www.bioware.com/legal/copyright.html
http://lilacsoul.revility.com/
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PPPPaaaaggggeeee    ooooffff    LLLLiiiinnnnkkkkssss

This page contains a dry list of every link used for reference, or links you might
find interesting..

Bioware web site:
http://nwn.bioware.com

Plot Editor Info
http://nwn.bioware.com/builders/plotwizard_tutorial.html

A Good Resource for Builders:
http://nwn.bioware.com/builders

For the most impressive script resource I have ever seen: Recommended!!!
http://lilacsoul.revility.com/

For various scripts from the Neverwinter Nights Vault:
http://nwvault.ign.com/Files/scripts/categories/Inventory%20ItemType%20-
%20Unique%20Items2.shtml

For extensive details and the best resource for understanding the script:
http://www.nwnlexicon.com/

Another great link for scripting resources and examples:
http://www.lemonbutter.com/

Another good link page:
http://www.sorcerers.net/Games/NWN/index_toolset3_4.htm

This link also has other references for scripting:
http://nwvault.ign.com/modules/wydraz/tutorial/

Sources for alternate guides:
http://nwn.bioware.com/builders/toolsetintro.html

NWN forum: Phenotypes:
http://nwn.bioware.com/forums/viewtopic.html?topic=338651&forum=48 .

Toolset tutorial on making encounters: (11 meg movie)
http://nwvault.ign.com/Files/movies/data/1028578623460.shtml

Hak Pack Tutorial:
http://nwvault.ign.com/Files/movies/data/1038173402360.shtml

http://nwn.bioware.com
http://nwn.bioware.com/builders/plotwizard_tutorial.html
http://nwn.bioware.com/builders
http://lilacsoul.revility.com/
http://nwvault.ign.com/Files/scripts/categories/Inventory%20ItemType%20-
http://www.nwnlexicon.com/
http://www.lemonbutter.com/
http://www.sorcerers.net/Games/NWN/index_toolset3_4.htm
http://nwvault.ign.com/modules/wydraz/tutorial/
http://nwn.bioware.com/builders/toolsetintro.html
http://nwn.bioware.com/forums/viewtopic.html?topic=338651&forum=48
http://nwvault.ign.com/Files/movies/data/1028578623460.shtml
http://nwvault.ign.com/Files/movies/data/1038173402360.shtml
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Hak Pack Examples:
http://downloads.gameplanet.co.nz/dl.dyn/Files/3210.html

Community Expansion Pack: “It’s All About “More””
http://nwn.bioware.com/players/cep.html

CEP Expanded Info as a pdf file (Adobe):
http://nwn.bioware.com/players/cep_Major_Features.pdf

CEP Movies:
http://nwvault.ign.com/Files/movies/data/1080028433040.shtml

Bioware’s Cashed Script Info:
http://nwn.bioware.com/developers/Bioware_Aurora_IFO_Format.pdf

http://downloads.gameplanet.co.nz/dl.dyn/Files/3210.html
http://nwn.bioware.com/players/cep.html
http://nwn.bioware.com/players/cep_Major_Features.pdf
http://nwvault.ign.com/Files/movies/data/1080028433040.shtml
http://nwn.bioware.com/developers/Bioware_Aurora_IFO_Format.pdf
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